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Obiectivele acestui modul sunt: 
 

 

 

 Cunoaşterea tastaturii ca dispozitiv de introducere a datelor şi în special de editare. Funcţiile 

mouse-ului 

 Descrierea diverselor tipuri de tastaturi 

  Funcţiile tastelor, taste speciale 

 Deplasarea cursorului mouse-lui, utilizarea butoanelor mouse-ului  

 

 Dobândirea deprinderilor de utilizare a tastaturii în procesul de procesare text sau grafică 

  Tastele de editare 

 Tastele funcţionale, rol 

  Shortcut-uri – combinaţii de taste 
 

 Enumerarea şi aplicarea operaţiilor de bază necesare prelucrării unui text 

  Lansarea în execuţie a unei aplicaţii de procesare de text 

 Deschiderea unui document existent – modificarea şi salvarea lui 

 Crearea unui document nou 

  Salvarea unui document 

 Închiderea unui document 

  Utilizarea  funcţiei „Ajutor” 

  Modul de vizualizare document 

 Închiderea aplicaţiei de procesare de text 
 

 Utilizarea operaţiilor de bază în procesarea textului 

 Iniţializarea paginii de lucru 

  Introducerea informaţiilor în text 

 Funcţia „Anulare” 

 Selectarea informaţiilor – caracter, cuvânt, paragraf, întregul document 

  Copierea, mutarea, ştergerea - folosirea comenzilor „ Copiere”, „Lipire”, „Decupare” 

 Căutarea şi înlocuirea – utilizarea comenzilor „Găsire” şi „Înlocuire” 
 

 Aplicarea diferitelor modalităţi de formatare a textului 

  Schimbarea dimensiunii şi tipului caracterelor 

  Folosirea stilului: bold (caractere aldine), italice (caractere cursive) şi subliniere. 

 Marcare vizuală (selectare) paragraf, text 

 Utilizarea culorilor în text 

  Alinierea textului în cadrul documentului 

  Spaţierea rândurilor 

 Copierea formatului unui text selectat 

 Folosirea şi setarea tabulatorilor: aliniere stânga, dreapta, centru, pe punctul zecimal, 

poziţionarea tabulatorilor 
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 Utilizarea avansată a procesorului de texte  

  Folosirea listelor (numerotare, marcatori) 

 Utilizarea instrumentelor pentru desenare 

 Inserarea şi formatarea tabelelor într-un document, operaţii în tabele 

 Inserarea şi formatarea diagramelor şi imaginilor 

 Formatarea finală a unui  document 

 Stiluri , aplicarea stilurilor existente unui document 

  Numerotarea paginilor 

 Antet şi subsol, introducerea datei, orei, numărului paginii 

 Corectarea greşelilor de ortografie şi a celor gramaticale - folosirea funcţiei de corectare 

ortografică şi gramaticală 

 

 Descrierea şi aplicarea corectă a  modului de tipărire a unui document 

  Trecerea în revistă a documentului (examinare înaintea imprimării) 

 Folosirea opţiunilor de bază pentru tipărire - fereastra Imprimare (Print) 

 Tipărirea documentului utilizând una din imprimantele instalate sau într-un fişier 

 

 Descrierea facilităţilor de utilizare a poştei electronice şi a faxului oferite de editor 

 Opţiunea „Trimite Poştă electronică” 

 Opţiunea „Trimite Fax prin Internet” 

 

 Realizarea unor aplicaţii practice 

 Sugestii: întocmirea unei cereri, realizarea unei diplome complexe, realizarea unei pagini 

pentru fax, realizarea unui raport, realizarea unei scrisori oficiale, întocmirea unui referat la 

o disciplină studiată  

 Organizarea aplicaţiilor realizate într-o structură de directoare proprie 

 

 Deprinderea redactării corecte  a unor documente 

  Reguli generale de tehnoredactare şi estetica paginii tipărite  

  Reguli de redactare a textelor oficiale sau de altă natură 

 Utilizarea „shortcut”-ului pentru funcţii mai des utilizate ale editorului 
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3.  Bazele utilizării procesoarelor de texte; Word din Microsoft Office 
 

Microsoft Office reprezintă o suită de aplicaţii de birou. Din cadrul suitei Microsoft Office 

amintim următoarele aplicaţii mai importante:  

- Microsoft Office Word 2007 (procesor de texte) – oferă posibilitatea de a crea, edita, formata, 

salva şi deschide documente text; documentele create pot include pe lângă text şi tabele, 

grafică, diagrame etc.. În mod prestabilit fişierele Word 2007 sunt salvate cu extensia docx. 

Documentele mai pot fi salvate şi în alte formate dintre care amintim Rtf şi PDF. 

- Microsoft Office Excel 2007 (calcul tabelar) – este o aplicaţie de calcul tabelar ce oferă 

posibilitatea de a introduce date, de a le analiza şi de a face calcule cu acestea; sunt incluse 

numeroase funcţii pentru operaţii matematice, statistice, financiare, de baze de date, de dată şi 

timp etc..  

- Microsoft Office PowerPoint 2007  (prezentare multimedia) – permite crearea de prezentări 

multimedia pe bază de diapozitive (slide-uri) care pot include alături de text şi grafică, tabele, 

diagrame şi animaţie.  

- Microsoft Office Access 2007 (baze de date) – oferă lucrul cu baze de date printr-o interfaţă 

simplă; pot fi create şi editate tabele, rapoarte, interogări, formulare. 

- Microsoft Office Outlook –  permite scrierea, trimiterea, primirea, citirea de e-mail. 

 

3.1. Folosirea aplicaţiei Microsoft WORD 

3.1.1.  Primii paşi în procesarea textelor 
 

Word este un procesor de texte complex şi eficient care oferă instrumentele necesare pentru a 

produce documente de diferite tipuri de la scrisori, referate şi cereri la buletine informative, cărţi, 

reviste şi pagini Web. Documentele se creează în fereastra Word, se salvează în fişiere şi pot fi 

modificate de câte ori este nevoie. Când se obţine varianta finală  aceasta poate fi imprimată, transmisă 

prin e-mail şi fax sau vizualizată pe Internet ca pagină Web. Word-ul este un procesor de texte minunat 

dar toate instrumentele sale – instrumente pentru culori, fonturi, obiecte grafice, rotire, panoramare şi 

altele – sunt numai o extensie a creativităţii dvs..  

Înainte de a începe să scrieţi documentul în Word este necesar să schiţaţi pe hârtie sau măcar în 

minte design-ul documentului. Pentru aceasta veţi avea în vedere răspunsul la următoarele întrebări: 

- Care este scopul documentului şi de ce este el necesar? 

- Care este audienţa? 

- Ce fel de informaţii va conţine? 

- Care este formatul general? 

- Ce tip de grafică este necesară şi câtă? 

- Care sunt cerinţele de imprimare? 

- Cum va fi distribuit? 

- Care este bugetul? 
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Elementele care asigură succesul unei publicaţii au la bază înţelegerea mesajului de transmis, a 

audienţei şi a resurselor. 

Dacă ignoraţi audienţa când scrieţi conţinutul şi proiectaţi design-ul unui document atunci cu 

siguranţă că documentul nu va fi citit. Tot ce are legătură cu documentul, de la stilul de scris până la 

calitatea hârtiei, contribuie la formarea imaginii despre transmiţătorul mesajului. Un design este bun 

dacă reuşeşte să capteze atenţia cititorului, să transmită mesajul şi acesta să fie reţinut o perioadă cât 

mai lungă. Prin urmare va trebui să vă gândiţi la conţinut, la formatul de pagină, număr de pagini şi de 

exemplare, ce fel de grafică folosiţi, cum aranjaţi textul şi grafica în pagină, ce tipuri de fonturi folosiţi 

şi de ce dimensiuni (pentru titluri, capitole, subcapitole şi pentru corpul principal al textului) etc. De 

asemenea pentru fiecare dintre aceste elemente stabiliţi impresia pe care doriţi să o producă: formal, 

informal, prietenos, elegant, clasic, trendy, conservator, provocator, divers etc. 
 

Pentru transpunerea design-ului publicaţiei în format electronic cu ajutorul unei aplicaţii de 

procesare de texte, în cazul de faţă cu Microsoft Word 2007, este indicat să stabiliţi de la început 

mărimea (A3, A4, A5, Letter etc.), orientarea (portret sau vedere) şi marginile paginii documentului. 

Dacă documentul va avea mai mult de o pagină atunci numerotaţi paginile fie în zona de antet fie în 

cea de subsol. Pentru aceasta veţi crea un antet sau un subsol pentru document.  
 

Acest modul prezintă elementele de bază ale tehnologiei procesoarelor de texte, necesare în 

realizarea unui design adecvat scopului propus şi utile pentru majoritatea persoanelor care nu au 

experienţă în artele vizuale şi în utilizarea tehnologiei de procesare de text dar care doresc să producă 

documente imprimate în scop comercial sau pentru uz personal. 
 

Dacă doriţi să scrieţi un text scurt unei cunoştinţe şi nu vă prea interesează aspectul acestuia 

atunci este suficient să citiţi primele două capitole din acest modul (3.1. „Folosirea aplicaţiei Microsoft 

WORD”; 3.2. Operaţii de bază în documente”) şi capitolul 3.5 „Pregătirea imprimării” eventual 3.6 

„Facilităţi de trimitere a unui document Word prin e-mail sau fax”. 
 

Dacă consideraţi că utilul şi frumosul ar trebui să meargă mână în mână, atunci citiţi şi capitolele 

3.3. „Formatarea” şi 3.4. „Obiecte”. 

 

 

3.1.1.1. Deschiderea şi închiderea aplicaţiei Word 
 

 Lansarea în execuţie a aplicaţiei  
 

După instalarea aplicaţiei pe calculator, pentru a lucra cu ea trebuie să o lansaşi în execuţie.  

Lansarea în execuţie se realizează astfel:  

În bara de aplicaţii (Taskbar) se alege Pornire → Toate programele → Microsoft Office → 

Microsoft Office Word 2007 (Start → All Programs → Microsoft Office → Microsoft Office Word 

2007): 
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 Interfaţa Microsoft Word 
 

După lansarea în execuţie a aplicaţiei Microsoft Office Word 2007, pe ecran va apărea fereastra 

aplicaţiei prezentată în figura următoare: 
 

 
 

Deoarece Microsoft Office Word 2007 poate fi personalizat, fereastra aplicaţiei poate arăta diferit 

de la un utilizator la altul, dar ea prezintă toate elementele cunoscute ale ferestrelor. 
 

Fereastra aplicaţiei prezintă un document nou cu numele Document1. Fiecare document va avea 

una sau mai multe pagini. 

Lucrarea Document1 are implicit o pagină. Pagina următoare apare automat atunci când se 
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umple cu informaţie prima pagină. La dorinţa utilizatorului se poate adăuga oricând o pagină nouă 

folosind combinaţia de taste Ctrl+Enter. Este important unde se află cursorul text (punctul de inserţie) 

în pagină, în momentul inserării unei pagini noi prin acest procedeu. Cursorul text apare sub forma 

unei liniuţe verticale pulsatoare. 
 

 

Interfaţa Word conţine elemente comune celorlalte aplicaţii Microsoft Office cum sunt: 
 

 Bara de titlu – conţine numele documentului curent şi al aplicaţiei; butoanele de minimizare, 

maximizare/refacere, închidere 

 Buton Office (Office Button)  - situat în colţul stânga sus al ferestrei aplicaţiei, permite 

accesul la comenzi de bază pentru lucru cu fişiere: deschidere fişier nou sau existent, salvare, 

imprimare, trimitere prin e-mail sau fax, închidere fişier, dar şi la opţiunile de personalizare a 

aplicaţiei prin butonul Opţiuni Word (Word Options) şi de închidere a aplicaţiei prin butonul 

Ieşire Word (Exit Word).  

 
 

 Bara de instrumente Acces rapid (Quick Access Toolbar)  – situată în 

dreapta butonului „Office”, conţine butoanele Salvare (Save), Anulare (Undo), Refacere 

(Redo) şi Particularizare bară de instrumente Acces rapid (Customize Quick Access 

Toolbar). Bara „Acces rapid” poate fi personalizată prin mutarea ei sub Panglică (Ribbon) şi 

prin adăugarea/ eliminarea de butoane.  
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 Panglica (Ribbon) – situată sub bara de titlu, este proiectată pentru a avea acces rapid la 

comenzile de care avem nevoie. Panglica (Ribbon) este parte a interfeţei numită „Microsoft 

Office Fluent”, interfaţă care înlocuieşte meniurile ierarhice şi barele de instrumente din 

versiunile anterioare cu comenzi organizate în file (tabs) şi grupuri. 

 

 
Pe Panglică (Ribbon) se găsesc toate comenzile, stilurile şi resursele necesare, aranjate logic 

pe tipuri de activităţi în file (tab-uri).  

Fiecare filă (tab) are un nume şi conţine grupuri, de exemplu Pornire (Home), Inserare 

(Insert), Aspect pagină (Page Layout), Referinţe (References) etc..  

Un grup conţine comenzi înrudite şi cuprinde controale cum ar fi: butoane, meniuri, casete 

de validare (Check box) şi casete combinate (Combo box). Fiecare grup are un nume ce 

apare sub butoane (Clipboard, Font etc.) şi unele dintre grupuri prezintă în dreapta numelui 

de grup un buton numit Lansator (Launcher) care deschide caseta de dialog asociată 

grupului.  

Pe Panglică (Ribbon) apar şi galerii de pictograme, ca de exemplu galeria Stiluri rapide 

(Quick Style Gallery) utilă la formatarea textului; dacă plasaţi cursorul mouse-ului peste o 

pictogramă din galerie (fără a da clic) atunci textul îşi schimbă temporar aspectul conform 

stilului indicat. 

Unele file (tab) sunt afişate numai dacă sunt necesare. De exemplu fila Instrumente 

imagine (Picture Tools) Format apare numai dacă aţi selectat o imagine. 

 

 
Este posibil ca pe Panglică (Ribbon) să nu fie vizibile toate pictogramele sau tot textul 

pentru o filă (tab).  Panglica este optimizată pentru un ecran cu rezoluţia de 1024x786 pixeli 

şi pentru o fereastră Word maximizată. Dacă fereastra sau rezoluţia este mai mică atunci 

grupurile din fila (tab) activă se restrâng pe orizontală şi la nevoie pictogramele care au fost 

afişate pe un rând pot apărea pe două sau trei rânduri sau se poate afişa o singură pictogramă 

prin care se face accesul la comenzi. 

Exemplu:  
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 Riglele gradate (Rulers) – orizontală şi verticală sunt utilizate pentru alinierea textului, 

graficii şi tabelelor în document. Riglele pot fi afişate/ascunse din butonul Riglă (Ruler) aflat 

în partea superioară a barei de derulare verticală sau bifând/debifând opţiunea Riglă (Ruler) 

din fila Vizualizare → grupul Afişare/Ascundere (View → Show/Hide): 

 

        
 

Unităţile de măsură în care sunt divizate riglele gradate se stabilesc din fereastra Opţiuni 

Word (Word Options) dacă se parcurge calea Buton Office → Opţiuni Word → secţiunea 

Complex → zona Ecran (Office Button → Word Options → secţiunea Advanced → zona 

Display): 

 

 
 

  Barele de defilare (Scroll bar) - pe orizontală şi verticală se afişează/ascund astfel: clic pe 

Buton Office → Opţiuni Word → Complex → zona Ecran (Office Button → Word Options 

→ Advanced → zona Display) se bifează/debifează Bară de defilare orizontală (Show 

horizontal scrool bar) şi/sau Bară de defilare verticală (Show vertical scrool bar). 

 Bara de stare (Status bar) – apare în partea de jos a ferestrei şi afişează informaţii cu privire 

la contextul de lucru. Ea poate fi personalizată prin adăugarea respectiv eliminarea de 

butoane dacă se dă clic-dreapta pe bară şi din meniul contextual se bifează/debifează 

opţiunile dorite. În general sunt afişate informaţii cum ar fi: numărul de pagină/nr. total 

pagini, număr total de cuvinte, limba, modurile de vizualizare document, procentul de 

vizualizare pentru panoramare (Zoom). 

 Minibară de instrumente (Mini toolbar) – conţine comenzi de formatare care apar în 

document acolo unde trebuie să le utilizaţi. Selectaţi un text şi veţi vedea Minibara de 

instrumente (Mini toolbar) chiar lângă textul selectat. 
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Exemplu: 

 
 

 Opţiuni lipire (Paste options) – apare în document în poziţia cursorului, sub forma 

unui buton, după o operaţie de lipire a unei secvenţe de text. Dacă daţi clic pe buton apare 

lista opţiunilor din care puteţi alege cum să fie lipit (paste) textul în document. 

 

 Meniuri contextuale – apar la clic-dreapta pe o filă (tab), pe un buton, în zona de text, pe un 

element de grafică etc. şi prezintă comenzi ce pot fi utilizate în contextul respectiv pentru 

elementul indicat.  

 

 Pagina documentului – reprezintă zona de lucru în care se introduce textul şi grafica şi apare 

sub forma unei coli albe de hârtie. Pagina documentului corespunde unei anumite mărimi şi 

orientări a foii de hârtie. Caracteristicile paginii se stabilesc din fila Aspect pagină → grupul 

Iniţializare pagină (Page Layout → grupul Page Setup). După introducerea textului şi 

eventual a graficii documentul se salvează ca fişier pe disc. Ulterior el poate fi deschis pentru 

vizualizare, modificare, imprimare sau trimitere prin fax sau e-mail. 

 

 Închiderea aplicaţiei Word 
 

Când aţi terminat de lucrat în Word închideţi aplicaţia. Pentru a închide aplicaţia Word alegeţi  

Buton Office → X Ieşire Word (Office Button → X Exit Word) sau faceţi clic pe butonul roşu  X  

Închidere (Close) aflat pe bara de titlu. 

 

 

3.1.1.2. Folosirea funcţiilor “ Ajutor” (Help) 
 

În aplicaţia Word 2007 pentru rezolvarea rapidă a unor probleme puteţi folosi funcţia Ajutor 

(Help). Ajutorul reprezintă un ghid interactiv ce conţine informaţii despre cum să utilizaţi Word-ul.  

 

 

 Cum folosim Ajutorul (Help-ul)?  

 Pentru comenzile din Panglică (Ribbon) obţineţi explicaţii dacă menţineţi câteva clipe 

cursorul mouse-ului peste buton. Va apărea o casetă cu explicaţii scurte numite Sfaturi ecran 

(ScreenTip). 

Exemplu:   
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 Pentru acces la fereastra Ajutor Word (Word Help) daţi clic pe butonul  Ajutor pentru 

Microsoft Office (Microsoft Office Word Help) din bara de file (tab-uri) a panglicii (Ribbon) 

sau apăsaţi tasta funcţională F1. În urma executării acestei comenzi, va apărea fereastra 

Ajutor Word (Word Help):  
 

 
 

Fereastra de ajutor (Help) poate fi redimensionată şi poziţionată oriunde pe ecran. Dacă în 

partea dreaptă-jos a ferestrei apare Offline atunci aveţi acces la ajutorul din fişierele salvate 

pe calculator. Dacă apare Conectat la Office Online (Connected to Office Online) atunci 

sunteţi conectaţi la ajutorul Office online. Se poate alege una dintre variante prin clic pe 

butonul respectiv şi selectarea uneia dintre oferte din meniul afişat. 

Accesul la informaţiile utile se poate face astfel:   

- Se pot parcurge capitolele din panoul stâng. Un capitol (carte) se deschide prin clic pe el. 

Se alege din ofertă unul dintre subiecte şi se dă clic. În panoul din dreapta va apărea 

dezvoltat subiectul ales.  Dacă panoul stâng nu apare atunci se efectuează clic pe butonul 

 Afişare cuprins (Show Table of Contents) aflat în bara de instrumente din partea de 

sus a ferestrei de ajutor. 

- În fereastra Ajutor Word (Word Help) se poate tasta un cuvânt în caseta Tastaţi cuvintele 

ce trebuie căutate (Type words to search for) pentru a primi informaţii punctuale. 

 Pentru o casetă de dialog utilizaţi pictograma   Ajutor (Help) din bara de titlu a casetei. 

Dacă există ajutor (help) disponibil pentru caseta de dialog atunci acesta va apărea automat, 

altfel va apărea fereastra Pornire (Home) a ajutorului. 
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3.1.1.3. Deschiderea unuia sau mai multor documente 
 

Din Word un document existent se deschide alegând Buton Office → Deschidere (Office Button 

→ Open) sau prin clic pe numele lui dacă acesta apare în lista Documente recente (Recent Documents 

la Office Button). De asemenea puteţi deschide un document Word din aplicaţia Computer dacă daţi 

dublu-clic pe pictograma fişierului. Fişierele create în Notepad şi în WordPad pot fi deschise cu 

aplicaţia Word. 
 

În Word se poate lucra cu mai multe ferestre document deschise simultan. 
 

3.1.1.4. Crearea unui document nou (folosind şablonul prestabilit) 

Un document nou se creează prin alegerea Buton Office → Nou → Document necompletat → 

Creare  (Office Button → New → Blank Document → Create). Va apărea o nouă fereastră Word cu un 

document numit „Document nr” ( unde nr este un număr dat automat) ce are o singură pagină.  
 

3.1.1.5. Salvarea unui document într-o locaţie pe disc 

Salvarea iniţială se realizează aşa cum aţi învăţat în aplicaţiile precedente: alegeţi din Buton 

Office →  Salvare (Office Button →  Save). În fereastra care va apărea, în caseta Salvare cu tipul 

(Save as type) alegeţi Document Word (Word Document (*.docx)). Prin această alegere vor rezulta 

fişiere cu extensia .docx (cea mai cunoscută extensie a aplicaţiei Word 2007). Introduceţi în caseta 

Nume fişier (File name) numele noului fişier, selectaţi discul şi dosarul (folder-ul) în care acesta să fie 

salvat şi daţi clic pe butonul Salvare (Save).  

 

 
 

Pe parcursul lucrului în Word este indicat să faceţi salvări intermediare Buton Office → Salvare 

(Office Button → Save).  



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 15 

 

Se pot efectua salvări mai rapid prin acţionarea butonului  Salvare (Save) din bara Acces 

rapid (Quick Access Toolbar) sau apăsând combinaţia de taste Ctrl + S. 

Pentru a proteja fişierul împotriva deschiderilor neautorizate sau împotriva modificărilor la 

salvare puteţi indica o parolă pentru deschidere şi/sau una pentru modificare: în fereastra Salvare ca 

(Save As) daţi clic pe Instrumente → Opţiuni generale (Tools → General Options…) pentru a 

deschide fereastra Opţiuni generale. 

 

Introduceţi parola pentru deschidere în caseta Parolă pentru deschidere (Password to open) 

şi/sau pentru modificare în caseta Parolă pentru modificare (Password to modify), daţi clic pe OK şi 

reintroduceţi parolele când vă sunt solicitate.  

Pentru a renunţa ulterior la parole se alege Buton Office → Salvare ca (Office Button → 

Save As) şi se repetă procedura de mai sus ştergând parolele introduse. 

Notă 

- În Word se poa 

- 3te alege să se lucreze cu copie de rezervă (siguranţă) pentru document dacă parcurgeţi calea: 

Buton Office → Opţiuni Word → Complex → zona Salvare → se bifează Întotdeauna 

copie de rezervă (Office Button → Word Options → Advanced → zona Save → se bifează 

Always create backup copy): 
 

 
 

Prin această acţiune se va copia versiunea precedentă a unui document ca o copie de rezervă 

(siguranţă), de fiecare dată când salvaţi documentul. Fiecare nouă copie de rezervă înlocuieşte 

precedenta copie de rezervă. Word salvează copia de rezervă în acelaşi folder cu originalul şi 

adaugă numelui de fişier cuvintele Copie de rezervă a numefişier. wbk  (Backup of numefişier. 
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wbk). Când lucrul într-un document eşuează se poate continua pe copia de rezervă a acestuia. 
 

- Se poate alege realizarea unei salvări periodice la un interval de timp stabilit de utilizator: 

Buton Office → Opţiuni Word → Salvare (Office Button → Word Options → Save) şi se 

bifează caseta Salvare informaţii de recuperare automată la fiecare (Save AutoRecover 

Information every). Această acţiune determină construirea automată a unui fişier de 

recuperare a documentului după trecerea fiecărui interval de timp introdus în caseta minute 

(minutes): valoare cuprinsă între 1 şi 120.  
 

 
 

În situaţia în care calculatorul dvs. nu mai răspunde la nici o comandă sau se întrerupe 

alimentarea cu energie în mod neaşteptat, Word-ul deschide fişierul de AutoRecuperare 

(AutoRecover. În momentul în care lansaţi din nou în execuţie aplicaţia, fişierul de 

AutoRecuperare (AutoRecover)poate conţine informaţii nesalvate care, altfel, s-ar fi pierdut din 

documentul original.  

Dacă documentul original a fost distrus, fişierul de AutoRecuperare (AutoRecover) vă poate 

ajuta să recuperaţi, eventual, informaţiile dorite. 
 

Observaţie: Recuperarea automată nu înlocuieşte comanda Salvare (Save) - este necesar în continuare 

să salvaţi documentul odată ce aţi terminat de lucrat cu el. 

 

 

3.1.1.6. Salvarea unui document sub alt nume 
 

Se pot aduce modificări în cadrul procesului de salvare dacă se alege Buton Office → Salvare ca 

(Office Button → Save As), acţiune care determină reapariţia ferestrei de salvare în care se va putea 

schimba discul, folderul în care se face salvarea, numele fişierului sau orice combinaţie a celor 

amintite. Prin această acţiune documentul salvat iniţial nu va fi afectat ci se va crea o copie a sa (dacă 

faceţi cel puţin o schimbare de disc, folder sau nume de fişier). 
 

Observaţie: Dacă nu se modifică nimic în cadrul procesului de salvare atunci Salvare ca (Save as)  

acţionează la fel ca şi Salvare (Save). 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 17 

 

3.1.1.7. Comutarea între mai multe documente deschise 
 

În Word se poate lucra cu mai multe ferestre deschise simultan. Pentru a comuta dintr-un 

document în alt document deschis: 

- se foloseşte fila Vizualizare → Comutare ferestre (View → Switch Windows) şi se dă clic pe 

numele unui document sau 

- se face clic pe butonul corespunzător din Bara de aplicaţii (Taskbar). 

 

 

3.1.1.8. Închiderea unui document 
 

Fereastra documentului activ se închide astfel: 

- Buton Office →  Închidere (Office Button → Close) sau 

- Clic pe butonul  x  Închidere (Close). Dacă a fost deschis un singur document atunci se va 

închide şi Word-ul. 

 

Dacă fişierul nu a fost salvat sau dacă s-au operat modificări de la ultima salvare atunci veţi fi 

întrebaţi dacă doriţi să salvaţi sau nu. 

 

 
 

 

 

 
 

 

Ce aţi învăţat în acest capitol? 
 

 Cum se porneşte şi cum se opreşte aplicaţia Microsoft Word. 

 Cum se deschide un document creat cu Microsoft Word. 

 Cum se creează un document nou cu Word-ul şi cum se salvează acesta într-o 

locaţie pe disc. 

 Cum se salvează un document dându-i-se un alt nume decât cel cu care a fost 

salvat anterior. 

 Cum se comută între mai multe documente deschise.  

 Cum se foloseşte ajutorul (Help). 

 Cum se deschide un fişier fără a închide aplicaţia Word.  
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3.1.2. Ajustarea setărilor de bază 
 

3.1.2.1. Schimbarea modului de vizualizare a paginii 
 

În fila Vizualizare, grupul Vizualizări documente (View, grupul Document Views), se găsesc 

comenzile pentru modurile de vizualizare a documentului.  

 

Aceste comenzi pot fi accesate şi din bara de stare. În dreapta barei există butoane care comută 

între diverse moduri de vizualizare. 

 

 
 

Aspect pagină imprimată (Print layout) - permite lucrul cu documentul exact aşa cum va arăta 

acesta după tipărire. Permite utilizarea tuturor facilităţilor aplicaţiei. Este modul curent de lucru. 

Citire în ecran complet (Full Screen Reading) – este o vizualizare optimizată pentru citirea 

documentului pe întregul ecran. Şi în această vizualizare se poate alege opţiunea de a vedea 

documentul aşa cum apare el la imprimantă. Ieşirea din acest mod se face prin accesarea butonului 

Închidere (Close) din colţul-dreapta sus al ferestrei. 

 

 

Aspect pagină Web (Web Layout) - prezintă documentul exact aşa cum va apărea acesta în 

programul de navigare (Browser). 
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Schiţă (Outline) - este un mod de vizualizare folositor atunci când utilizatorul doreşte să creeze 

un plan preliminar sau să revizuiască planul în timpul dezvoltării unui document. 

 

 

 

Ciornă (Draft) – nu apar vizualizate marginile paginilor; scrisul curge pagină după pagină şi 

trecerea la o altă pagină este evidenţiată printr-o linie orizontală punctată. 

 

 
 

Observaţie: Veţi studia aplicaţia Word în modul de vizualizare Aspect pagină imprimată (Print 

layout). 
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3.1.2.2. Folosirea funcţiei de modificare a scării de vizualizare a unui 
document (panoramare) 

 

Factorul de panoramare al documentului poate fi mărit sau micşorat pentru a vedea o zonă mai 

mare, respectiv mai mică din document. Accesul la comenzile de panoramare (zoom) se face din fila 

Vizualizare, grupul Panoramare (View, grupul Zoom) sau din Bara de stare (Status bar). 

 

 

 Din fila Vizualizare (View) alegerea  Panoramare  (  Zoom) permite modificarea 

după nevoie a factorului de panoramare: 

 

 
 

În fereastra Panoramare (Zoom), se poate alege direct factorul de panoramare Panoramare la 

(Zoom to), sau se poate introduce acesta în caseta Procent (Percent). Pentru a vizualiza întreaga 

lăţime sau mărime a paginii se alege Lăţime pagină (Page width) respectiv Pagină întreagă 

(Whole page), iar pentru a vizualiza mai multe pagini în acelaşi timp se alege Multe pagini 

(Many Pages). 

 

 Zona Panoramare (Zoom) din bara de stare permite modificarea factorului de panoramare 

prin glisarea  indicatorului sau prin clic pe unul dintre butoanele  sau . 

 

Observaţie: Modificările factorului de panoramare nu au nici un fel de efecte asupra mărimii reale a 

paginii şi a caracterelor (textul va fi prezentat ca şi cum ar fi privit printr-o lupă care 

măreşte sau micşorează). 
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3.1.2.3. Afişarea, ascunderea barelor de instrumente 
 

 Panglica (Ribbon) poate fi minimizată (apar numai denumirile de file) şi reafişată la nevoie 

prin bifarea/ debifarea opţiunii Minimizare Panglică (Minimize the Ribbon), accesibilă fie 

din butonul Particularizare bară de instrumente Acces rapid (Customize Quick Access 

Toolbar) aflat pe bara Acces rapid (Quick Acces Toolbar), fie din meniul contextual ce apare 

la clic dreapta pe zona panglicii.  

De asemenea se poate da dublu-clic pe numele tab-ului activ sau se poate apăsa combinaţia 

de taste Ctrl + F1. 

 

Panglica (Ribbon) nu poate fi eliminată şi nici înlocuită cu meniurile şi barele de instrumente 

(toolbars) din versiunile anterioare de Word. 

 

 Bara Acces rapid (Quick Acces Toolbar) poate fi afişată sub Panglică dacă se alege butonul 

Particularizare bară de instrumente Acces rapid (Customize Quick Access Toolbar) aflat pe 

bara Acces rapid (Quick Acces Toolbar) şi apoi Afişare dedesubtul panglicii (Show Below 

the Ribbon). 

 Pentru lucrul rapid poate fi folosită Minibara de instrumente (Mini toolbar), o bară în 

miniatură ce oferă comenzi de formatare pentru textul selectat.  

Dacă bara nu apare atunci se activează prin alegerea Buton Office → Opţiuni Word → 

Populare → se bifează Afişare minibară de instrumente la selectare (Office Button → Word 

Options → Popular → se bifează Show Mini Toolbar on selection). 
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3.1.2.4. Afişarea, ascunderea caracterelor neimprimabile  
 

Documentul creat în Word pe lângă textul propriu-zis conţine şi alte caractere care nu apar la 

imprimare dar care sunt necesare pentru controlul formatării textului din document. Acestea se numesc 

caractere neimprimabile sau caractere de formatare. Pentru a afişa/ascunde toate caracterele de 

formatare (tabulatori, spaţii, marcaje paragraf, alte marcaje de formatare) se alege una dintre 

variantele: 
 

a)   Din Panglică: fila Pornire grupul Paragraf  (Home→ Paragraph) butonul  
 

b) Din caseta de dialog Opţiuni Word (Word Options): Buton Office → Opţiuni Word → 

Afişare → zona Se afişează întotdeauna marcajele de formatare pe ecran (Office Button → 

Word Options → Display → zona Always show formatting marks on the screen) se bifează  

opţiunile corespunzătoare caracterelor ce se doresc afişate. 

 

 
 

 

 

Ce aţi învăţat în acest capitol? 
 

 Cum se ajustează setările de bază ale Word-ului (personalizarea interfeţei). 

- Cum se schimbă modul de vizualizare a paginii. 

- Cum se modifică scara de vizualizare a unui document. 

- Cum se afişează şi cum se „ascund” barele de instrumente şi caracterele 

neimprimabile (de formatare). 
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3.2.  Operaţii de bază în documente 
 

3.2.1. Introducerea informaţiilor în documente 
 

3.2.1.1. Introducerea textului în documente 
 

Introducerea textului în document se poate realiza prin: tastare, copiere, mutare, etc.. Prin 

tastare, textul apare în locul în care se află cursorul de inserare text (liniuţa pulsatoare).  
 

Rândurile de text curg automat pe măsură ce tastaţi textul, nefiind necesară acţionarea tastei 

Enter la capăt de rând. Ele sunt reajustate automat dacă redimensionaţi pagina, modificaţi marginile 

sau schimbaţi dimensiunea fontului. 
 

Prin apăsarea tastei Enter se creează un nou paragraf. Paragraful reprezintă textul introdus între 

două apăsări ale tastei Enter. Word-ul  tratează fiecare paragraf ca o entitate separată, având informaţii 

proprii de formatare.  
 

 Cum introduceţi text de la tastatură? 
 

1.  Plasaţi cursorul de inserare/inserţie text în locul în care doriţi să introduceţi textul. 

2.  Vă comutaţi pe modul Inserare (Insert) sau Sprascriere (Overtype). 

3.  Tastaţi textul dorit. 
 

 

Dacă se doreşte suprascrierea textului existent, se poate trece la modul suprascriere. Pentru a 

comuta între modurile inserare şi suprascriere se execută clic pe butonul Inserare (Insert) sau 

Suprascriere (Overtype) din bara de stare. Dacă butonul nu este vizibil atunci se dă clic-dreapta pe 

bara de stare şi se bifează Suprascriere (Overtype).  

 

Pentru comutare se poate 

utiliza şi tasta Insert dacă se alege 

Buton Office → Opţiuni Word → 

Complex →   Se utilizează tasta 

Ins pentru a controla modul de 

suprascriere (Office Button → Word 

Options → Advance→   Use the 

Insert key to control overtype 

mode): 
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3.2.1.2. Introducerea caracterelor speciale, a simbolurilor 
 

Prin caracter special înţelegem orice caracter care nu apare pe tastatură. De exemplu € ®  ©  ½  

¼ ±  ≥  ≤  ≠  ÷  ∞ ¬  »  ¥  Ω ∑ µ  sunt caractere speciale. 
 

Pentru a preveni separarea a două cuvinte la final de rând se foloseşte caracterul Spaţiu 

neseparator (Non-breaking space) între cele două cuvinte, în loc de spaţiul normal.  
 

De asemenea pentru ca liniuţa de legătură dintre două cuvinte să nu apară la final de rând se 

utilizează Cratimă neseparatoare (non-breaking hyphen). De exemplu dacă textul ”Ana-Maria” se 

găseşte la final de rând şi dorim să rămână cele două cuvinte împreună se foloseşte între ele liniuţa 

cratimă neseparatoare (non-breaking hyphen). 

 

 Pentru a introduce în document caractere speciale parcurgeţi paşii: 
 

1. Plasaţi cursorul text în locul unde doriţi să inseraţi caracterul. 

2. Alegeţi tab-ul Inserare → grupul Simbol → Simbol → Mai multe simboluri (Insert → 

grupul Symbol → Symbol → More Symbols).  

3. În caseta care va apărea faceţi clic pe fila Caractere speciale (Special Characters): 

 

 

4. În zona Caracter (Character:) faceţi clic pe caracterul dorit şi apoi pe butonul Inserare 

(Insert).  

5. Caseta de dialog se închide efectuând clic pe butonul Închidere (Close) sau pe butonul  X .  
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 Pentru a introduce în document simboluri parcurgeţi paşii: 
 

1.  Plasaţi cursorul text în locul unde doriţi să inseraţi simbolul. 

2. Alegeţi Inserare → grupul Simbol → Simbol (Insert →  grupul Symbol → Symbol). 

3. În caseta care va apărea faceţi clic pe o ofertă: 

 
 

Pentru a vedea mai multe oferte efectuaţi clic pe Mai multe simboluri (More Symbols…) şi 

apoi pe fila Simboluri (Symbols): 

 

 
 

Din lista Font selectaţi Fontul dorit. În zona caracterelor faceţi clic pe un caracter şi apoi pe 

butonul Inserare (Insert).  

Caseta de dialog se închide efectuând clic pe butonul Închidere (Close) sau pe butonul  X  al 

casetei de simboluri. 
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3.2.2. Selectarea informaţiilor 
 

3.2.2.1. Selectarea unui caracter, cuvânt, paragraf, întregul corp al textului 
 

Înainte de a muta, copia, formata sau de a efectua alte operaţii cu un text acesta trebuie mai întâi 

selectat. Word permite selectarea textului care se află în secvenţă (consecutiv) cât şi a blocurilor 

(secvenţelor) de text care nu sunt consecutive. 

Selectarea textului în Word  se realizează făcând clic cu mouse-ul la o extremitate a textului care 

se doreşte a fi în selecţie şi apoi glisând mouse-ul până la cealaltă extremitate a textului.  

De asemenea, puteţi selecta zone de text poziţionând cursorul text la începutul zonei respective 

şi apăsând tasta Shift împreună cu tastele cu săgeţi în sensul selecţiei. 

Pe lângă aceste modalităţi de selecţie există variante mai rapide, unele dintre acestea fiind 

prezentate în continuare. 

Un cuvânt se selectează dacă se execută dublu-clic pe cuvântul respectiv. 

O propoziţie se selectează prin Ctrl+clic oriunde în interiorul propoziţiei. 

Selectarea unui rând se realizează mutând cursorul mouse-ului pe marginea din stânga a 

rândului (săgeata mausului îşi schimbă direcţia spre dreapta ), apoi se execută clic. 

Selectarea unui număr de rânduri se face astfel: se mută cursorul mouse-ului pe marginea din 

stânga a primului rând (săgeata mausului îşi schimbă direcţia spre dreapta ), apoi se execută clic şi se 

glisează mouse-ul (în zona din stânga) în dreptul rândurilor ce se doresc a fi în selecţie. 

Un paragraf se poate selecta executând triplu clic în interiorul lui sau dublu clic în stânga lui. 

Pentru selectarea întregului text se alege fila Pornire → grupul Editare Selectare → Selectare 

totală (Home → grupul Edit → Select → Select all) sau se dă triplu clic în stânga textului. 
 

De asemenea, puteţi selecta zone de text poziţionând cursorul text la începutul zonei respective 

şi apăsând tasta Shift împreună cu tastele cu săgeţi în sensul selecţiei. 

F8  activează modul selecţie Extindere selecţie (Extend); cu clic sau tastele săgeţi selectaţi text 

în continuare până la ieşirea din acest mod prin Esc .  

 

Alte modalităţi de selectare a textului sunt prezentate în tabelul următor: 

 

Apăsaţi această tastă 

sau combinaţie de taste 

Pentru a extinde selecţia 

Shift+← Peste caracterul anterior 

Shift+→ Peste caracterul următor 

Shift+↑ Pe rândul de mai sus 

Shift+↓ Pe rândul de mai jos 
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Shift+Ctrl+← 

Până la începutul cuvântului curent (sau al 

cuvântului anterior, dacă sunteţi la începutul 

unui cuvânt) 

Shift+Ctrl+→ Până la începutul cuvântului următor 

Shift+Ctrl+↑ 
Până la începutul paragrafului curent (sau cel 

anterior dacă sunteţi la începutul unui paragraf) 

Shift+Ctrl+↓ Până la sfârşitul paragrafului curent 

Shift+Home Până la începutul rândului 

Shift+End Până la capătul rândului 

Shift+Ctrl+Home Până la începutul documentului 

Shift+Ctrl+End Până la sfârşitul documentului 

 

Notă  Pentru a deselecta zona selectată se execută un clic în document sau se apasă o tastă săgeată. 

 

 

3.2.3. Editarea informaţiilor 
 

3.2.3.1. Editarea conţinutului prin inserarea unor noi caractere, cuvinte în 
cadrul unui text existent, suprascrierea pentru a înlocui un text 
existent 

 

Textul introdus în document poate fi modificat (pot fi inserate, şterse  sau suprascrise caractere,  

cuvinte, sau secvenţe mai mari de text). 

Pentru a modifica un text este necesar să mutaţi cursorul text (punctul de inserţie/inserare) în 

locul unde se va face operaţia de editare. 

 Pentru a deplasa cursorul text în cadrul documentului se poate folosi maus-ul sau tastatura. 

 

 Deplasarea punctului de inserţie cu ajutorul mausului 
 

Se face clic în document în poziţia în care se doreşte să se opereze o schimbare. 

 

 Deplasarea punctului de inserţie/inserare cu ajutorul tastaturii 
 

 

 

Tastă sau combinaţie de taste 

 

 

Punctul de inserţie se mută: 

← Înaintea caracterului anterior 

→ După următorul caracter 
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 ↑  Un rând mai sus 

 ↓  Un rând mai jos 

Ctrl+ ← Înapoi câte un cuvânt 

Ctrl+ → Înainte câte un cuvânt 

Ctrl+  ↑  Înapoi câte un paragraf 

Ctrl+  ↓    Înainte câte un paragraf 

Home La începutul rândului 

End La sfârşitul rândului 

Ctrl+Home La începutul documentului 

Ctrl+End La sfârşitul documentului 

 

 Cum se introduc caractere sau cuvinte noi? 
 

1. Vă asiguraţi că nu sunteţi în modul de scriere suprascriere - în bara de stare nu apare 

Suprascriere (Overtype). 

2. Poziţionaţi cursorul de inserare în locul dorit (folosind maus-ul sau tastele săgeţi pentru 

deplasare). 

3. Tastaţi noul text. 
 

 Pentru a suprascrie un text (a înlocui textul existent cu cel ce va fi tastat) parcurgeţi paşii: 
 

1. Asiguraţi-vă că în bara de stare Suprascriere (Overtype) este evidenţiat, altfel apăsaţi tasta 

Insert sau faceţi clic în bara de stare pe butonul Inserare (Insert). 

2. Plasaţi cursorul de inserare în poziţia dorită. 

3. Tastaţi textul dorit.  

 

3.2.3.2. Folosirea comenzilor „Anulare” (Undo) şi „Refacere” (Redo) 

În cazul în care aţi tastat un text greşit, sau aţi dat o comandă greşită aveţi posibilitatea să anulaţi 

aceste acţiuni prin comanda Anulare (Undo). Comanda Refacere (Redo) inversează acţiunea comenzii 

pentru anulare, adică anulează ultima Anulare, sau ultimele Anulări. Refacerea (Redo) se utilizează în 

cazul în care  nu aţi intenţionat să anulaţi o acţiune, şi are ca efect  revenirea la situaţia dinainte de a da 

comanda Anulare (Undo). 

Aveţi acces la comenzile Anulare (Undo) şi Refacere (Redo) prin taste rapide sau din bara de 

instrumente Acces rapid (Quick Access Toolbar). 
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 Anularea ultimei acţiuni 
 

În bara Acces rapid (Quick Access Toolbar) faceţi clic pe butonul  Anulare (Undo), sau 

apăsaţi combinaţia de taste Ctrl+  Z . 

Observaţie: Dacă nu se poate anula ultima acţiune atunci numele butonului se schimbă în Imposibil de 

anulat (Can’t Undo). 

 

 Anularea mai multor acţiuni în acelaşi timp 
 

Microsoft Word afişează o listă a celor mai recente acţiuni pe care aveţi posibilitatea să le 

anulaţi.  
 

1. În bara Acces rapid (Quick Access Toolbar), faceţi clic pe săgeata din dreapta butonului 

Anulare (Undo); va apărea o listă cu cele mai recente acţiuni pe care Microsoft Word le poate 

anula.  

2. Faceţi clic pe acţiunea pe care doriţi să o anulaţi. Dacă nu vedeţi acţiunea în listă, pentru a o 

vizualiza, utilizaţi bara de derulare asociată listei.  

 

Observaţie: Când anulaţi o acţiune din listă, se anulează de asemenea, toate acţiunile situate înaintea ei.  

 

 Refacerea (Redo) ultimei acţiuni anulate 
 

În bara Acces rapid (Quick Access Toolbar), faceţi clic pe butonul  Refacere (Redo), sau 

apăsaţi combinaţia de taste Crtl  + Y.  
 

Observaţie: Dacă nu se poate reface ultima anulare atunci numele butonului se schimbă în Imposibil 

de refăcut (Can’t redo). 

 

 Refacerea  în acelaşi timp a mai multor acţiuni anulate 
 

1. În Acces rapid (Quick Access Toolbar), faceţi clic pe săgeata din dreapta butonului Refacere 

(Redo); va apărea o listă cu cele mai recente acţiuni pe care Microsoft Word le poate reface.  

2. Faceţi clic pe acţiunea pe care doriţi să o refaceţi. Dacă nu vedeţi acţiunea în listă, utilizaţi 

bara de derulare asociată listei, pentru a o vizualiza.  

 

Observaţie:  - Când refaceţi o acţiune din listă, se refac de asemenea, toate acţiunile situate înaintea ei. 

- Butonul de  Refacere (Redo) apare numai după a anulare cu  (Undo), în restul 

timpului el este buton de Repetare (Repeat) ,repetă ultima acţiune.  
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3.2.4. Copierea, mutarea şi ştergerea unui text 
 

3.2.5. Copierea textului în acelaşi document sau în alte documente 
deschise 

 

O facilitate a sistemelor de operare de tip Windows este memoria Clipboard, care permite 

stocarea temporară de text şi grafică.  

Avantajele memoriei Clipboard: 

- se pot muta sau copia texte sau grafică în cadrul aceluiaşi document; 

- se pot efectua operaţii de copiere, respectiv mutare şi între documente Word diferite; 

- se pot muta sau copia texte sau grafică între diferite aplicaţii din Windows; 

- informaţia rămâne în Clipboard şi după ce o lipiţi (Paste) undeva, ceea ce permite să inseraţi 

de mai multe ori aceeaşi informaţie prin operaţii repetate de lipire. 

 

 Copierea textului în acelaşi document se realizează parcurgând  paşii: 
 

1. Se selectează textul dorit (sursă). 

2. Se alege fila Pornire → grupul Clipboard → Copiere  (Home, grupul Clipboard → Copy ) 

sau se apasă Ctrl + C. 

3. Se plasează cursorul de inserare la destinaţie (clic cu mausul). 

4. Se alege fila Pornire → grupul Clipboard → Lipire  (Home, grupul Clipboard → Paste) sau 

se apasă Ctrl + V. 

 

Observaţie: După comanda Copiere  (Copy)  textul sau obiectul selectat va rămâne în document, iar o 

copie a lui va fi plasată în Clipboard.  

 

 Copierea textului în alt document deschis se realizează parcurgând  paşii: 
 

1. Se face activ documentul sursă şi selectăm textul (sursă). 

2. Se alege fila Pornire → grupul Clipboard → Copiere  (Home, grupul Clipboard → Copy). 

3. Se activează documentul destinaţie, apoi se poziţionează cursorul de inserare în locul 

unde va fi mutat textul (clic cu mausul în locul dorit). 

4. Se alege fila Pornire → grupul Clipboard → Lipire  (Home, grupul Clipboard → Paste). 
 

Notă 

- În această versiune de Word există un Clipboard multiplu în care se pot păstra mai multe 

informaţii pentru a le putea insera pe oricare din ele într-un document Office. În cazul în care 

plasaţi prin copiere sau decupare mai mult de 24 de elemente în Clipboard, Clipboard-ul Office 

va şterge primul element plasat şi apoi va colecta al 25-lea element. Elementele colectate rămân 

în Clipboard-ul Office până când închideţi toate programele Office care rulează pe calculator. 
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Pentru aceasta se afişează panoul de activitate Clipboard în care vor apărea toate informaţiile 

stocate în această memorie (va fi plasată câte o pictogramă reprezentând informaţia adăugată). 

Pentru lipirea informaţiei dorite în document se execută clic pe elementul dorit în fereastra 

Clipboard, informaţia apărând acolo unde e punctul de inserare. Clipboard-ul se goleşte cu clic 

pe butonul Golire completă (Clear All) din panoul de activitate Clipboard. 

 

Pentru a vizualiza panoul Clipboard daţi clic pe fila Pornire (Home), şi în grupul Clipboard pe 

butonul din colţul dreapta jos: 
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Pentru a închide Clipboard-ul daţi clic pe butonul  x  din fereastra Clipboard. 

 

- În cadrul aceleiaşi ferestre document se poate folosi mouse-ul pentru a copia rapid un text, 

urmând paşii: 

1.  Se selectează textul. 

2.  Se plasează indicatorul mouse-lui pe textul selectat, se apasă tasta CTRL şi se menţine apăsată, 

se execută clic şi se ţine butonul stâng al mouse-ului apăsat, apoi se  glisează către destinaţie, 

la final se eliberează mouse-ul şi apoi tasta CTRL. 

 

Această facilitate este activă dacă se alege: Buton Office → Opţiuni Word → Complex     Se 

permite glisarea şi fixarea textului (Office Button → Word Options → Advance →    Allow 

text to by dragged and dropped) → OK. 

 

 
 

 

3.2.5.1. Mutarea textului în acelaşi  document sau în alt document  

Dacă o anumită secvenţă de text nu este scrisă în locul potrivit atunci se mută secvenţa în poziţia 

corectă. Prin mutare textul dispare de la sursă şi apare la destinaţie. 
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 Mutarea textului în acelaşi document se realizează parcurgând  paşii: 
 

1. Se selectează textul (sursă). 

2. Se alege Pornire, grupul Clipboard → Decupare (Home, grupul Clipboard → Cut) sau se 

apasă Ctrl + X. 

3. Se poziţionează cursorul mausului la destinaţie şi se face clic. 

4. Se alege din fila  Pornire, grupul Clipboard → Lipire  (Home, grupul Clipboard → Paste). 
 

Observaţie: După comanda Decupare (Cut) textul sau obiectul selectat dispare din document, iar o 

copie a lui va fi plasată în Clipboard. 

 

 Mutarea textului în alt document deschis se realizează parcurgând  paşii: 
 

1. Se face activ documentul sursă şi se selectează textul (sursă). 

2. Se alege fila Pornire grupul Clipboard → Decupare (Home, grupul Clipboard → Cut). 

3. Se face activ documentul destinaţie, apoi se poziţionează cursorul de inserare în locul 

unde se doreşte a fi mutat textul (clic cu mausul în locul dorit). 

4. Se alege din fila Pornire, grupul Clipboard → Lipire ( Home, grupul Clipboard → Paste). 
 

Observaţie: Memoria Clipboard, permite stocarea temporară de text şi ilustraţii. După comanda 

Decupare (Cut) textul sau obiectul selectat dispare din document, iar o copie a lui va fi 

plasată în Clipboard. În această versiune de Word există un Clipboard multiplu în care se 

pot decupa mai multe informaţii pentru a le putea insera ulterior pe oricare dintre ele într-

un document Office.  

Notă  În cadrul aceleiaşi ferestre document se poate folosi mouse-ul pentru a muta rapid un text: 

1.  Se selectează textul. 

2.  Se plasează indicatorul mouse-ului pe selecţie, se execută clic, se ţine butonul stâng al mouse-

ului apăsat şi se  glisează către destinaţie. 

Această facilitate este activă dacă se alege: Buton Office → Opţiuni Word → Complex →   Se 

permite glisarea şi fixarea textului (Office Button → Word Options → Advance →    Allow 

text to by dragged and dropped) → OK. 

 

 

3.2.5.2. Ştergerea textului 
 

Un text care introdus, poate fi uşor şters folosind tastele Backspace sau Delete. Alte variante: 
 

Tasta Acţiunea 

BACKSPACE  Ştergerea unui caracter din stânga cursorului de inserare  

CTRL+BACKSPACE  Ştergere unui cuvânt la stânga  

DELETE  Ştergerea unui caracter la dreapta 

CTRL+DELETE  Ştergerea unui cuvânt la dreapta 

CTRL+X  Decuparea textului selectat şi inserarea în Clipboard 

Dacă se doreşte ştergerea unui text mai lung printr-o singură operaţie, textul respectiv trebuie 

selectat, după care se apasă tasta Delete. 
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3.2.6. Caută şi înlocuieşte 

3.2.6.1. Folosirea comenzii de căutare a unui text într-un document 
 

Găsirea şi înlocuirea unor fragmente de text este una dintre cele mai rapide modalităţi de a 

efectua modificări repetitive asupra unui document.  

Comanda Find (găsire) se referă la identificarea poziţiei unui şir de caractere, iar Replace 

(înlocuire) înlocuieşte şirul de caractere (porţiune de text) găsit cu unul nou.  

Pentru utilizarea acestor comenzi, se alege fila Pornire → grupul Editare → Găsire → Găsire 

(Home → grupul Editing → Find → Find) şi în fereastra care se deschide se introduce şirul de 

caractere ce se doreşte a fi găsit în caseta De găsit (Find what) şi se apasă butonul Următorul găsit 

(Find Next). La fiecare găsire a şirului de caractere căutat, procesul de căutare se opreşte, textul găsit 

fiind selectat. Prin apăsarea butonului Următorul găsit (Find Next) procesul de căutare continuă.  

 

 
 

 

Din lista Găsire în (Find in) se poate selecta unde să se facă căutarea Documentul principal, 

Anteturi şi subsoluri (Main Document, Header anf Footers) etc.. 

 

 

3.2.6.2. Folosirea comenzii de înlocuire a unui cuvânt sau a unei fraze 
 

În unele cazuri este necesar ca textul găsit să fie înlocuit cu un altul. Pentru aceasta se alege 

Pornire → Editare → Înlocuire (Home → Editin g→ Replace). Se introduce şirul de caractere ce se 

doreşte a fi găsit în caseta De găsit (Find what) iar în caseta Înlocuire cu (Replace with) se introduce 

textul cu care se face înlocuirea. Se începe căutarea cu clic pe Următorul găsit (Find Next). Cu clic pe 

butonul Înlocuire (Replace) textele găsite se vor înlocui unul câte unul, iar dacă în unele locuri nu se 

doreşte substituirea textului găsit, se apasă butonul Următorul găsit (Find Next); cu clic pe butonul 

Înlocuire peste tot (Replace All) înlocuirea se va face automat în tot documentul.  
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Notă 

Dacă se bifează opţiunea Potrivire litere mari şi mici (Match case) atunci la găsirea textului se 

va fi ţine cont de tipul literelor (majuscule şi minuscule). 

Dacă se bifează opţiunea Numai cuvinte întregi (Find whole words only) atunci textul căutat 

trebuie să fie cuvânt, nu parte dintr-un cuvânt.  

Dacă aceste opţiuni nu apar atunci daţi clic pe butonul Mai multe>> (More). 
 

 

 

Ce aţi învăţat în acest capitol? 

 Cum se introduc textele, caracterele speciale şi simbolurile în document. 

 Cum se selectează un caracter, un cuvânt, un paragraf sau întregul corp al 

documentului, în vederea editării. 

 Cum se inserează noi caractere sau cuvinte într-un text existent şi cum se face 

înlocuirea unui text existent prin suprascriere. 

 Cum revenim la situaţia iniţială după executarea unor comenzi greşite: Anulare şi 

Refacere (Undo şi Redo). 

 Cum executăm copieri, mutări sau ştergeri ale unei secvenţe de text în interiorul 

unui document sau între mai multe documente deschise. 

 Cum căutăm într-un document un fragment de text şi cum îl înlocuim pe acesta cu 

altul. 
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3.3.  Formatarea 

3.3.1.   Formatarea caracterelor 

Textul introdus într-un document poate fi formatat, adică aspectul lui poate fi modificat. 

Formatarea textului se referă atât la alegerea tipului de font, a stilului fontului, a dimensiunii sau 

culorii lui, cât şi la alegerea distanţei (spaţierii) dintre caractere.  

Înainte de face orice formatare textul trebuie selectat. Dacă nu este selectat un text, atunci 

formatările stabilite se vor aplica textului care se va introduce începând cu poziţia curentă a cursorului 

text (punctului de inserţie). 

Formatările se realizează din fila Pornire → grupul Font (Home→ grupul Font). Unele comenzi 

de formatare se află pe panglică (butoane şi liste derulante care permit selectarea unui font, a unei 

dimensiuni a fontului, a unor efecte etc.), altele pot fi selectate din caseta de dialog Font dacă se 

activează lansatorul casetei de dialog  Font (aflat în dreapta numelui grupului). 
 

 
 

 

                

3.3.1.1. Schimbarea aspectului textului: dimensiune şi tip font 

 

 Schimbarea tipului de font aplicat textului 
 

1. Se selectează textul ce se doreşte a fi modificat. 

2. În grupul Font se face clic pe numele fontului din lista Font.  

Exemplu:  

 
 

 Schimbarea dimensiunii (mărimii) fontului aplicat textului: 
 

1. Se selectează textul ce se doreşte a fi modificat. 

2. În grupul Font se selectează dimensiunea din lista Dimensiune font (Font Size), sau se 

tastează o valoare în casetă şi apoi se apasă tasta Enter. De asemenea se pot utiliza butoanele  

 Creştere font (Grow Font) respectiv Reducere font (Shrink Font) pentru a 

mări/micşora dimensiunea caracterelor. 

Exemplu:  
 

Acest text este scris cu fontul Times New Roman de dimensiune 16. 
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3.3.1.2. Folosirea formatării de tip: Aldin (Bold), Cursiv (Italic), Subliniere 
(Underline) 

 

Grupul Font conţine butoane şi liste derulante care permit scrierea cu caractere aldine, cursive 

sau subliniate. 

 

 Cum aplicăm formatare de tip Bold (aldină, îngroşată) ? 
 

1.  Selectăm textul pe care dorim să-l modificăm. 

2.  În grupul Font facem clic pe butonul  Aldin (Bold). 

 

 Cum aplicăm formatare de tip Italic (cursivă) ? 
 

1.  Selectăm textul pe care dorim să-l modificăm. 

2.  În grupul Font facem clic pe butonul  Cursiv (Italic). 

 

 Cum aplicăm formatare de tip Underline (subliniere) ? 
 

1.  Selectăm textul pe care dorim să-l modificăm. 

2.  În grupul Font facem clic pe butonul  Subliniere (Underline). Dacă dorim un anumit 

model de subliniere atunci îl selectăm din lista derulantă Subliniere (Underline) care apare la 

clic pe săgeata din dreapta butonului. 
 

 

Exemplu:  Text scris cu fontul Arial, stilul Aldin, subliniat cu linie dublă. 
 

Text scris cu fontul Arial, stilul Cursiv, subliniate numai cuvintele. 
 

Text scris cu fontul Times New Roman, 

stilul Obişnuit, fără subliniere. 
 

 

 

 

 

 

Notă 

Se poate folosi şi caseta de dialog Font pentru 

formatarea caracterelor (clic pe butonul Font din 

bara de titlu a grupului Font). 

Din fila Font se pot modifica opţiuni legate de font 

şi atributele caracterelor: 
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Din fila Spaţiere caractere (Character 

Spacing) se poate modifica spaţiul dintre 

caractere.  

Se pot dispersa sau condensa caracterele unui 

text selectat, dacă în lista Spaţiere (Spacing) se 

alege Extinsă (Expanded) sau Condensată 

(Condensed) iar în caseta La: (By:) se 

introduce distanţa cu care se doreşte să se 

extindă sau să se micşoreze spaţierea dintre 

caractere. Această casetă este goală dacă 

selectaţi Normală (Normal) în caseta Spaţiere 

(Spacing).  

În lista Poziţie (Position) se poate coborî sau 

ridica textul selectat faţă de linia de scriere 

dacă se alege Ridicată (Raised) sau Coborâtă 

(Lowered) şi se introduce valoarea în caseta 

La: (By:) cu care să se ridice sau să se coboare 

textul selectat faţă de linia de scriere.  

 

Dacă în caseta de dialog Font se fac diverse alegeri şi se părăseşte caseta cu clic pe butonul 

Implicit (Default) va părea o casetă asemănătoare celei din imagine: 

 

 
 

 

Dacă se execută clic pe Da (Yes) se vor memora valorile curente din tab-urile Font şi  Spaţiere 

caractere (Character Spacing) ca setări implicite pentru documentul activ şi pentru restul 

documentelor ce se vor deschide ulterior. 

Observaţie: Din grupul Font se poate alege  Anulare formate (Clear Formatting) pentru a anula 

toate formatările aplicate textului selectat. 

 

3.3.1.3. Trecerea unui text în format Indice (subscript) sau Exponent 
(superscript) 

 Trecerea unui text în format exponent sau indice  
 

1.   Se selectează textul ce se doreşte a fi scris sub formă de exponent sau indice.  

2.   În grupul Font se efectuează clic pe butonul  Indice (Subscript) sau pe  Exponent 

(Superscript). 
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Notă  
Se poate folosi şi caseta Font, fila Font pentru formatare de tip exponent respectiv indice: 

 

                   
              

 

Exemplu:    X
2
+2

3
=0                                Ai+Bj=5 

 

3.3.1.4. Modificarea textului în majuscule, minuscule etc. 

 

Dacă s-a introdus un text cu majuscule şi ar fi trebuit scris cu litere mici (sau invers) nu se şterge 

textul pentru a-l introduce din nou cu litere mici, sau invers deoarece există posibilitatea transformării 

caracterelor în mod automat. 

 

 Transformarea textului se realizează parcurgând paşii: 
 

1. Se selectează textul ce se doreşte a fi modificat. 

2. Se alege din lista Modificare majuscule/minuscule (Change Case)  prin clic pe varianta 

dorită. 

 

 
 

Exemplu:  
 

Ana învaţă să folosească procesorul de texte WORD.  
 

 

ANA ÎNVAŢĂ SĂ FOLOSEASCĂ PROCESORUL DE 

TEXTE WORD. 
 

 

ana învaţă să folosească procesorul de texte word. 
 

 

Ana învaţă să folosească procesorul de texte WORD. 

 

Textul transformat în: 

MAJUSCULE (UPPERCASE) 

Textul transformat în: 

cu litere mici (lowercase) 

 

Textul transformat în: 

Caz propozişie (Sentence case) 

Textul iniţial 
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Ana Învaţă Să Folosească Procesorul De Texte WORD. 

 

 
 

aNA ÎNVAŢĂ SĂ FOLOSEASCĂ PROCESORUL DE 

TEXTE word. 

 

 

3.3.1.5. Folosirea diferitelor culori în text 

 Schimbarea culorii textului 
 

1. Se selectează textul a cărui culoare doriţi să fie modificată. 

2. Se execută clic pe butonul  Culoare font (Font color) aflat în 

grupul Font; această operaţie are ca efect aplicarea ultimei culori 

folosite.  

Dacă se doreşte aplicarea unei alte culori se execută clic pe săgeata 

din dreapta butonului Culoare font (Font color) şi se alege culoarea 

dorită: 

Exemplu: 

 Acest text este scris cu verde. 

 

 Schimbarea culorii de fond a textului 
 

1. Se selectează textul a cărui culoare de umbrire se doreşte a fi 

modificată. 

2. Se alege fila Pornire → grupul Paragraf,  Umbrire (Home 

→ Paragraph → Shading). Textului selectat i se va aplica 

ultima culoare folosită. Dacă se doreşte aplicarea unei alte culori 

se execută clic pe săgeata de lângă butonul Umbrire (Shading) şi 

se alege culoarea dorită:  

Pentru renunţarea la culoarea de fundal se alege Fără culoare 

(No Color). Pentru a avea acces la alte culori se alege Mai multe culori (More Colors). 
 

Exemplu:  

Acest text este scris pe fond galben. 

 

 Evidenţierea textului prin marcarea lui cu un marker colorat 
 

Dacă utilizatorul doreşte să atragă atenţia asupra unei anumite regiuni din text se poate evidenţia 

textul respectiv prin utilizarea butonului  Culoare evidenţiere text (Text Highlight Color) din 

grupul Font fila Pornire (Home). Acesta este echivalentul computerizat al utilizării unui marker de 

culoare, pe hârtie. Se poate alege culoarea din ofertele din lista de culori asociată „marker-ului”. Butonul 

salvează ultima culoare folosită. 

Cum se procedează pentru a colora textul cu un marker? 

Textul transformat în: 

Fiecare cuvânt cu majusculă 

(Capitalize Each Word) 

Textul transformat în: 

cAZ  cOMUTARE (tOGGLE 

cASE) 
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1.  Se selectează textul ce urmează a fi marcat. 

2.  Se efectuează clic pe butonul  aflat în grupul Font; textul va fi marcat în culoarea 

curentă. 

Dacă se doreşte marcarea cu o anumită culoare se dă clic pe săgeata din dreapta butonului şi 

se alege culoarea dorită.  

Dacă se doreşte renunţarea la culoarea de marcare se alege din lista de culori asociată 

„marker-ului” varianta  Fără culoare (No Color). 
 

Notă    Dacă se dispune de o imprimantă color atunci textul va apărea evidenţiat la tipărire.   

 

Observaţie: Se poate obţine acelaşi efect şi procedând astfel: fără a selecta text se alege culoarea 

pentru „marker” apoi se glisează peniţa deasupra textului ce se doreşte evidenţiat (se pot 

marca mai multe texte). Indicatorul de evidenţiere va fi activ până la efectuarea unui nou 

clic pe butonul  . 

 

3.3.1.6. Copierea formatului de la un text la un alt text 

Dacă vă place cum este formatat un text, aveţi posibilitatea să copiaţi formatul acestui text şi să-l 

aplicaţi altui text. Această facilitate este oferită de funcţia Descriptor de formate (Format Painter). 

 

 Copierea formatului de la un text la alt text se realizează astfel: 
 

1. Se selectează textul al cărui format se doreşte a fi aplicat la alt 

text. 

 

2. În fila  Pornire (Home), grupul Clipboard se face clic pe butonul 

Descriptor de formate (Format Painter). 

3. Se selectează textul destinaţie (cel căruia i se va aplica noul 

format). 

 

 Formatarea poate fi copiată la mai multe porţiuni de text ce nu se află una în continuarea 

celeilalte parcurgând paşii: 
 

1. Se selectează textul al cărui format se doreşte a fi copiat. 

2. În tab-ul Pornire (Home), grupul Clipboard se face dublu-clic pe butonul Descriptor de 

formate (Format Painter).  

3. Se selectează pe rând fiecare porţiune de text la care se va aplica formatarea. 

4. Când s-a terminat de aplicat formatul se apasă tasta ESC sau se face clic pe butonul 

Descriptor de formate (Format Painter) pentru a-l dezactiva. 
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3.3.1.7. Aplicarea unui stil existent unui cuvânt, unei linii, unui paragraf 

Stilurile în Word permit salvarea formatărilor existente şi aplicarea acestora altor texte. În stiluri 

se pot include denumiri de fonturi, dimensiuni de fonturi, atribute ale fonturilor, aliniere, spaţiere între 

caractere, spaţiere în cadrul paragrafului, marcatori şi numerotare automată, margini şi cam toate 

formatările posibile. După crearea unui stil, tot ceea ce trebuie făcut pentru aplicarea stilului respectiv 

unui text selectat este selectarea stilului dintr-o listă. Dacă se modifică un stil, toate textele care 

folosesc stilul respectiv se modifică în mod automat. 
 

 Aplicarea unui stil unui cuvânt, unei linii, unui paragraf 

1. Se selectează cuvântul, linia, sau paragraful ce urmează a fi modificat. 

2. În fila Pornire → grupul Stiluri (Home → Styles) se efectuează clic pe pictograma unui stil.  

Dacă stilul nu apare pe panglică  atunci se pot afişa alte stiluri prin clic pe Rândul nr1 din nr2 

(Row nr1 to nr2) sau prin clic pe săgeata listei derulante Mai multe (More).   

 

De asemenea se poate utiliza lista Modificare stiluri (Change Styles) sau lansatorul casetei de 

dialog Stiluri (Styles): 

                   

Observaţie: - Dacă se plasează cursorul mouse-ului pe o pictogramă din galeria de stiluri atunci textul 

selectat îşi va schimba temporar stilul. 

- În Word se pot selecta rapid toate textele care au aceeaşi formatare. Se execută clic cu 

butonul drept al mausului pe un cuvânt ce prezintă formatarea dorită şi din meniul de 

context se alege Stiluri → Selectare text cu formatare asemănătoare (Style → Select Text 

with Similar Formatting). Acest lucru este foarte util atunci când se doreşte modificarea 

formatărilor. 
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3.3.1.8. Folosirea despărţirii automate în silabe (automatic hyphenation) 

În mod obişnuit aplicaţia Microsoft WORD nu desparte cuvintele în silabe la sfârşitul unei linii 

de text. Dacă un cuvânt nu încape în linie atunci el este mutat automat la începutul liniei următoare.  

Dacă textul este aliniat Stânga-dreapta (Justify) atunci acest lucru poate conduce la un aspect 

inestetic al textului (spaţii mari între cuvinte). Pentru a evita acest aspect neplăcut, se poate utiliza 

caracteristica de despărţire automată în silabe. 

Despărţirea automată în silabe se poate aplica 

întregului document, sau numai unui text selectat. 

 

 Despărţirea automată în silabe a 

întregului document 
 

1. Ne asigurăm că nu este nici un text 

selectat. 

2. Se alege fila Aspect pagină → grupul 

Iniţializare pagină → Despărţire în 

silabe (Page Layout → grupul Page Setup → Hyphenation): 
     

 

Pentru despărţire automată în silabe se alege Automat (Automatic), pentru despărţire manuală 

Manual şi pentru anularea despărţirii în silabe se alege Fără (None). 

 

Pentru alte opţiuni se efectuează clic pe Opţiuni hibernare (Hyphenation Options…) şi se va 

deschide următoarea casetă de dialog: 
 

    

 Se bifează caseta Despărţire automată în silabe în document (Automatically hyphenate 

document); dacă se doreşte şi despărţirea în silabe a cuvintelor scrise în întregime cu 

majuscule, atunci se bifează şi Despărţire în silabe cuvinte cu MAJUSCULE (Hyphenate 

words in CAPS). 

3. În caseta Zonă de despărţire în silabe (Hyphenation zone) se stabileşte ce distanţă să rămână  

de la ultimul cuvânt din linie până la marginea din dreapta (aceasta este zona în care un 

cuvânt trebuie să fie despărţit în silabe). 

4. În caseta Limitare cratime consecutive la: (Limit consecutive hyphens to), se stabileşte 

numărul de linii consecutive ce pot fi despărţite în silabe. 

5. Se închide caseta de dialog executând clic pe butonul OK. 

 

 Despărţirea automată în silabe a unei părţi din document 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 44 

 

 

Pentru aceasta se stabileşte mai întâi textul care să nu fie despărţit în silabe şi se formatează 

corespunzător iar apoi se face despărţirea automată în silabe: 

1. Se selectează textul ce va fi despărţit în silabe. 

2. Se parcurg paşii 2-6 de la despărţirea în silabe a întregului document.   

Observaţie: Dacă se desparte în silabe tot documentul şi nu numai textul selectat atunci se va selecta 

textul ce nu va fi despărţit în silabe. Se alege fila Pornire → lansatorul casetei de dialog 

Paragraf → fila Sfârşit de linie şi de pagină (Home → butonul  Paragraph → fila Line 

and Page Breaks), apoi se bifează caseta Fără despărţire în silabe (Don’t hyphenate); se 

închide caseta de dialog cu clic pe butonul OK. 

 

 Eliminarea despărţirii în silabe 
 

Dacă s-a utilizat despărţirea automată în silabe atunci se parcurg paşii: 
 

1. Se alege Aspect pagină → grupul Iniţializare pagină → Despărţire în silabe (Page Layout 

→ grupul Page Setup → Hyphenation) 

2. Se selectează Fără (None). 

 

 

3.3.2. Formatarea paragrafelor 
 

3.3.2.1. Introducerea, ştergerea marcajelor de paragraf 
 

La introducerea textului în document, trecerea la o altă linie se realizează automat, în momentul 

în care cursorul text (punctul de inserţie) ajunge la capătul liniei. Nu este nevoie să se apese, ca la 

maşinile de scris clasice tasta Retur de car (Carriage return, Enter) pentru a trece la linia următoare.  

Totuşi există numeroase situaţii în care indiferent de formatările aplicate textului, se doreşte ca 

un anumit aliniat să înceapă întotdeauna într-o linie nouă. Din perspectiva Microsoft WORD acest 

lucru se realizează inserând un nou paragraf. 

Un paragraf nou se introduce prin apăsarea tastei Enter. Aceasta provoacă o întrerupere de linie 

în text (în poziţia în care se află punctul de inserţie) şi trecerea cursorului text (punctul de inserţie) la 

linia următoare.  

Altfel spus “Paragraful” reprezintă textul introdus între două apăsări consecutive ale tastei 

Enter. Word-ul  tratează fiecare paragraf ca o entitate separată, ce are informaţii proprii de formatare. 
 

În document, în locul în care s-a apăsat tasta Enter se introduce un caracter care poartă numele 

de marcaj de paragraf. Acest caracter nu este vizibil pe ecran în mod obişnuit şi nu apare nici la 

imprimarea documentului. La dorinţa utilizatorului el poate fi afişat. În acest caz marcajele de paragraf 

apar afişate în document sub forma ¶ . 

 

 Introducerea unui marcaj de paragraf (sfârşit de paragraf) 
 

1. Se poziţionează punctul de inserţie în locul unde dorim să întrerupem un paragraf. 

2. Se apasă tasta Enter. 

Observaţie: Dacă există text după poziţia punctului de inserţie, atunci după apăsarea tastei Enter acest 
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text va migra pe următoarea linie. 
 

Exemplu: 

 

Procesorul de texte Microsoft WORD ne oferă posibilitatea să edităm uşor un 

text. Textul introdus este structurat în entităţi numite paragrafe. 
 

 

Plasăm punctul de inserţie înaintea cuvântului Textul aşa cum apare arătat mai 

jos şi apoi apăsăm tasta Enter. 

 

Procesorul de texte Microsoft WORD ne oferă posibilitatea să edităm uşor un 

text.│Textul introdus este structurat în entităţi numite paragrafe. 
 

 

În poziţia în care am apăsat Enter va fi inserat un marcaj de paragraf, iar textul 

aflat în dreapta punctului de inserţie va coborî pe următoarea linie. 
 
 

Procesorul de texte Microsoft WORD ne oferă posibilitatea să edităm uşor un 

text.  

Textul introdus este structurat în entităţi numite paragrafe. 

 

 

 Ştergerea unui marcaj de paragraf 
 

1. Se afişează marcajele de paragraf (vezi afişarea marcajelor de paragraf în continuarea acestui 

capitol).   

2. Se şterge caracterul ¶ ca orice alt caracter (se foloseşte tasta Delete sau Backspace). 

 

 Afişarea respectiv ascunderea marcajelor de paragraf 
 

 Se poate folosi una dintre următoarele două variantele: 
 

A) Caseta de dialog Opţiuni Word (Word Options). 
 

B) Butonul  Afişare totală (Show/Hide). 
 

A) Se parcurge calea: Buton Office → Opţiuni Word  (Office Button → Word Options).  
 

Pe ecran va apărea caseta de dialog din care se va selecta prin clic Afişare (Display): 
 

Textul iniţial 

Rezultatul 

după ce am 

apăsat Enter 

Punctul de 

inserţie 
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În secţiunea Se afişează întotdeauna marcajele de formatare pe ecran se bifează  

Marcaje paragraf (Always show formatting marks on the screen se bifează  Paragraph 

marks). 

Se închide caseta de dialog prin clic pe butonul . 
 

B) Se va utiliza butonul  din fila Pornire (Home), grupul Paragraf  (Paragraph): 

-  afişarea marcajelor: se face clic pe butonul . 

-  ascunderea marcajelor: dacă butonul este activat   se face clic pe el pentru a-l 

dezactiva (nu vor mai fi afişate marcajele). 
 

Observaţie: Utilizarea butonului  are ca efect afişarea tuturor marcajelor invizibile (nu numai a  

marcajelor indicate în caseta Word Options).  

 

Exemplu: text cu marcaje de paragraf afişate  

 

Această linie de text se termină cu un marcaj de paragraf ¶ 

¶ 

¶ 

Un marcaj de paragraf apare şi la începutul unei linii goale¶ 

Acest paragraf cuprinde două linii de text; la finalul primei linii nu s-a apăsat tasta 

Enter; textul a migrat automat pe linia a doua¶ 
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3.3.2.2. Introducerea, ştergerea marcajelor de întrerupere linie (soft 
carriage return) 

 

Întreruperea de linie (soft carriage return) se utilizează pentru a nu se forţa trecerea la o linie 

nouă prin apăsarea tastei Enter (adică prin inserarea unui nou paragraf), sau prin introducerea de spaţii 

până la finalul liniei. 

  

 Introducerea marcajelor de întrerupere linie se realizează astfel: 
 

1. Se plasează cursorul text în locul unde dorim să întrerupem linia. 

2. Se apasă combinaţia de taste Shift + Enter . 

 

 Ştergerea marcajelor de întrerupere linie se realizează astfel: 
 

1. Se afişează marcajele de formatare: clic pe butonul  . 

2. Se şterge marcajul de întrerupere de linie (caracterul ) ca orice alt caracter (cu tasta Delete 

sau Backspace). 

 

 

3.3.2.3. Alinierea textului la stânga, la centru, la dreapta, la stânga-dreapta 
(Justify) 

Alinierea orizontală a textului dintr-un paragraf determină aspectul marginilor liniilor 

paragrafului: aliniere la stânga, aliniere la dreapta, la centru sau aliniere stânga-dreapta. 
 

Aliniere text la stânga (Align Text Left)     - liniile paragrafului vor fi aliniate în partea stângă. 

Aliniere text la dreapta (Align Text Right) - liniile paragrafului vor fi aliniate în partea dreaptă. 

La centru (Center)                  - liniile paragrafului vor fi centrate. 

Stânga-dreapta (Justify)                  - liniile paragrafului vor fi aliniate atât în partea stângă cât 

şi în partea dreaptă (spaţiile dintre cuvintele textului 

selectat vor fi condensate sau extinse).  

 

          
 

     Aliniere text la stânga   Aliniere text la dreapta          La centru                     Stânga-dreapta 

    (Align text Left)              (Align text Right)                     (Center)                        (Justify) 
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 Pentru a alinia un text se poate utiliza una dintre variantele:  

 

A)  Alinierea textului folosind butoanele din panglică (Ribonn): 
 

1. Se selectează textul ce se doreşte a fi aliniat. 

2. În fila Pornire→ grupul Paragraf  (Home → grupul Paragraph), se face clic pe unul 

dintre butoanele: 
  

 Aliniere text la stânga (Align Text Left),  

 Aliniere text la dreapta (Align Text Right),  

 La centru (Center),  

 Stânga-dreapta (Justify). 

 

B)  Alinierea textului folosind caseta de dialog Paragraf (Paragraph): 
 

1. Se selectează textul ce se doreşte a fi aliniat. 

2. Se dă clic pe lansatorul casetei de dialog Paragraf  (Paragraph) din bara de titlu a 

grupului Paragraf  (Paragraph): 

 

 
 

3. În fila Indentări şi spaţiere (Indents and Spacing) se alege varianta dorită din lista 

derulantă Aliniere (Alignment). 

4. Clic pe butonul  pentru a închide caseta de dialog Paragraf  (Paragraph). 
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Observaţie: Dacă alinierea aleasă este stânga-dreapta (Justify) şi ultimul rând din paragraf este mai 

scurt decât celelalte atunci acesta nu va fi aliniat stânga-dreapta ci la stânga. Se poate 

remedia această situaţie dacă se poziţionează punctul de inserţie la sfârşitul ultimului rând 

din paragraf şi se apasă tastele Shift + Enter (se introduce un Soft carriage-return).  
 

În Word, dacă într-o zonă liberă, se execută dublu-clic în partea stângă a zonei de lucru se 

va scrie aliniat la stânga, dublu clic în mijlocul zonei de lucru textul se va introduce 

aliniat centrat, dublu clic în dreapta zonei de lucru se va scrie aliniat la dreapta. Pentru ca 

această facilitate să fie activă se alege Buton Office → Opţiuni Word → Complex → 

zona Opţiuni editare,  Activare Se face clic şi se tastează (Office Button → Word 

Options → Advanced, zona Editing Option,  Enable click and type). 

 

 
 

 

3.3.2.4. Indentarea (retragerea) paragrafelor: la stânga, la dreapta, prima 
linie, agăţat 

 

Liniile cu text ale unui paragraf se întind în mod obişnuit de la marginea din stânga a paginii 

până la marginea din dreapta. În unele situaţii dorim ca anumite paragrafe să aibă o aliniere diferită de 

a celorlalte (de exemplu să înceapă mai din interiorul marginilor paginii, sau să se termine înainte de 

marginea din dreapta a paginii). Acest lucru se poate face prin operaţia de indentare. 
 

Indentarea stabileşte distanţa la care se află un paragraf faţă de marginea din stânga şi faţă de 

marginea din dreapta. Există de asemenea posibilitatea de a crea o indentare diferită pentru prima linie 

din paragraf faţă de celelalte linii (sau un indent agăţat, în care prima linie a paragrafului nu este 

indentată, iar restul liniilor sunt). 
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 Aplicaţia Word pune la dispoziţia utilizatorului mai multe modalităţi de a indenta textul 

dintr-un paragraf:  
 

A) Rigla gradată. 

B) Caseta de dialog Paragraf (Paragraph) din fila Pornire (Home).  
 

A) Utilizarea riglei. Pe rigla orizontală sunt patru marcatori (butoane glisante) pentru stabilirea 

indentărilor, după cum apar în figura următoare:  
 

 
 

- Indent prima linie (First Line indent) 

produce deplasarea primei linii din paragraf 

spre dreapta sau stânga; are acelaşi efect ca şi 

apăsarea tastei Tab  în faţa primei linii din 

paragraf 
 

- Indent agăţat (Hanging indent) trimite 

celelalte linii din paragraf spre dreapta primei 

linii atunci când acest marcator este poziţionat 

în dreapta marcatorului de Indent prima linie 

(First line indent): 

 
 

- Indent stânga (Left Indent) delimitează un 

paragraf de restul textului prin îndepărtarea 

tuturor liniilor de text de marginea stângă a 

documentului: 

 

 

- Indent dreapta (Right Indent) îndepărtează 

textul de marginea din dreapta a 

documentului: 

 

 

 
 

- Indent dreapta (Right indent) este folosit, în 

general, cu un indent stânga (Left indent) 

pentru a crea o indentare duală (indentările 

duale se folosesc în general pentru scoaterea în 

evidentă a unor citate):  

Acest text are indentată 

prima linie, iar restul liniilor nu 

sunt indentate. 

Acest text nu are indentată 

prima linie, iar restul 

liniilor  sunt  indentate. 

 

Acest text este 

indentat la stânga. Este 

indentat la stânga. 

 

Acest text este 

indentat la dreapta. Acest 

text este indentat dreapta. 

 

Acest text este 

indentat şi stânga şi 

dreapta. Acest text este 

indentat la stânga şi la 

dreapta. 
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Pentru a modifica indentările pentru un text existent folosind rigla: 
 

1. Se selectează paragraful (paragrafele) ce urmează a fi indentat. 

2. Se glisează cu mouse-ul spre stânga respectiv spre dreapta marcatorul (butonul) 

corespunzător de pe riglă.   . 

 

B) Caseta de dialog Paragraf (Paragraph) 
 

1. Se selectează paragraful (paragrafele) ce urmează a fi indentat. 

2. Se alege Pornire → Paragraf → lansatorul casetei de dialog Paragraf (Home → 

Paragraph → butonul Paragraf); se va deschide caseta de dialog Paragraf (Paragraph):  

 

 
 

Acest text este 

indentat şi stânga şi 

dreapta. Prima linie este 

indentată diferit de 

celelalte linii. 
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3. Se face clic pe fila Indentări şi spaţiere (Indents and Spacing). 

În zona Indentare (Indentation), în casetele Stânga: (Left), Dreapta: (Right) se modifică 

distanţa de indentare (se efectuează clic pe săgeţile orientate în sus sau în jos, sau se pot 

introduce numere cu zecimală direct în casete).  

În lista Special: se poate selecta:  

-  Prima linie (First Line) pentru o indentare a primului rând de text din paragraf.  

-  Agăţat (Hanging) pentru a indenta restul liniilor din paragraf mai puţin prima linie. 

-  distanţa de indentare se precizează în caseta La: (By:).  

4. Se face clic pe butonul  pentru a aplica indentarea şi a închide caseta Paragraf 

(Paragraph). 
 

Observaţie: Indentările se pot stabili şi înainte de a introduce textul. Se poziţionează punctul de inserţie 

în locul dorit; se stabilesc indentările; se tastează în continuare textul. Aceste indentări se 

vor aplica textului ce se va introduce până la modificarea parametrilor de indentare. 

 

3.3.2.5. Spaţierea rândurilor unui paragraf 

Distanţa dintre rândurile unui paragraf poate fi modificată. Spaţierea rândurilor stabileşte 

dimensiunea spaţiului vertical dintre liniile textului unui paragraf. În mod obişnuit liniile de text sunt 

spaţiate la un rând. 

 

 Spaţierea rândurilor unui paragraf se realizează astfel: 
 

1. Se selectează paragraful/ paragrafele. 

2. Se alege fila Pornire → Paragraf →  Spaţiere rânduri (Home → Paragraph → butonul 

Line spacing). 
 

 
 

3. Se selectează una dintre variante. Pentru accesul la alte variante de spaţiere se alege Opţiuni 

spaţiere linie (Line Spacing Options) care va afişa caseta de dialog următoare: 
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În fila (eticheta) Indentări şi spaţiere (Indents and Spacing:) din lista Interlinie (Line 

spacing) se alege varianta convenabilă. Se execută clic pe butonul OK pentru a închide 

caseta. 

Observaţie: Spaţierea La un rând (Single) înseamnă că se oferă spaţiu pentru cel mai mare Font folosit 

în acea linie, la care se adaugă un mic spaţiu suplimentar. Spaţierea La două rânduri 

(Double) oferă spaţiu dublu faţă de spaţierea la un rând. 

Pentru a spaţia toate liniile în mod egal indiferent de mărimea fontului utilizat, selectăm 

din lista Interlinie: (Line spacing:) varianta Exact (Exactly) iar în caseta La: (At:) 

specificăm dimensiunea spaţiului vertical dorit. Acest spaţiu trebuie să fie suficient pentru 

ca să încapă în linie cel mai mare caracter utilizat în liniile paragrafului. Dacă textul apare 

decupat (trunchiat), se va mări spaţierea dintre rânduri în caseta La: (At:). 

Notă 

Se pot aplica şi alte spaţieri dacă în lista Interlinie (Line spacing) se selectează una din 

variantele: Cel puţin (At least), Exact (Exactly) sau Multiplă (Multiple). Pentru fiecare dintre 

aceste variante se poate introduce o valoare în caseta La: (At:). 

 

3.3.2.6. Aplicarea spaţierii înainte şi după paragraf 

Când se apasă tasta Enter pentru a începe un paragraf nou, spaţierea de dinaintea respectiv de 

după paragraful anterior este continuată şi la noul paragraf. Această spaţiere se poate modifica pentru 

fiecare paragraf în parte. 

 

mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\Office10\1048\wdmain10.chm::/html/worefElementsOfParagraphFormatting.htm##
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 Modificarea spaţierii dinainte şi de după paragraf 
 

1. Se selectează paragraful sau paragrafele pentru care dorim să schimbăm spaţierea. 

2. Se alege Pornire → Paragraf, lansatorul Paragraf (Home → Paragraf, lansatorul 

Paragraph). 

Va apărea caseta Paragraf (Paragraph); apoi se face clic pe fila Indentări şi spaţiere (Indents 

and Spacing:). 

3. În zona Spaţiere (Spacing) se poate stabili o spaţiere între paragrafe.  

În lista Înainte (Before) se stabileşte dimensiunea spaţiului de deasupra fiecărui paragraf 

selectat.  

În lista După (After) se stabileşte dimensiunea spaţiului de după fiecare paragraf selectat. 

 
 

4. Se închide caseta Paragraf (Paragraph) prin clic pe butonul OK. 

 

Notă 

Paragrafele mai pot fi spaţiate şi astfel: se alege Aspect pagină →  grupul Paragraf  şi se indică 

o valoare în caseta Înainte respectiv După (Page Layout → grupul Paragraf, caseta Before 

respectiv After). 
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Exemplu: 

 
 

3.3.2.7. Stabilirea, ştergerea şi utilizarea tabulatorilor:  
 

Pentru alinierea textului se pot folosi şi stopurile de tabulare (tabulatori). Pentru aceasta se 

apasă tasta Tab. Tasta Tab se utilizează în mod obişnuit asemănător tastei Spaţiu. Prin apăsarea tastei 

Tab se poate insera în document un spaţiu mai mare, a cărui lungime implicită este de 1,27cm 

Tabulatori impliciţi (Default tab stops). Astfel prin apăsarea tastei Tab se fac salturi în document spre 

dreapta, în poziţii care se află la o distanţă multiplu de 1,27cm. 
 

În afară de tabulatorii impliciţi pot fi stabiliţi şi alţi tabulatori (stopuri de tabulare). Aceştia 

determină saltul în document (cu ajutorul tastei Tab) într-o poziţie precizată anterior. Ei permit 

alinierea textului în raport cu tipul lor: la stânga, la dreapta, la centru sau după un marcator zecimal 

(sau caracter bară). De asemenea există posibilitatea de a insera automat înaintea tabulatorilor, 

caractere de umplere “Indicator” (în spaţiul rămas neocupat de text), cum ar fi puncte sau linii. 

 

 Modificarea spaţierii dintre tabulatorii impliciţi 
 

1. Se alege fila Pornire → grupul Paragraf,  Paragraf →  (Home → Paragraph,  

 Paragraph → ). 

2. În caseta Tabulatori impliciţi: (Default tab stops:), se introduce valoarea spaţierii prestabilite 

dintre tabulatori. 

3. Clic pe butonul OK  pentru a închide caseta Tabulatori (Tabs). 
 

 
 

Aceste două paragrafe sunt spaţiate între ele. Înaintea paragrafelor s-au 

lăsat 12 pct. (pt), iar după paragrafe  6 pct (pt). 

Acest lucru înseamnă că între aceste două paragrafe avem un spaţiu de 

12+6=18 puncte.  
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Observaţie: dacă se modifică spaţierea dintre tabulatorii impliciţi atunci automat se va modifica şi 

spaţierea textului din document în locul unde au fost utilizaţi aceşti tabulatori.  

 

 Afişarea şi ascunderea marcajului de Tabulare în document  
 

Se pot face vizibile pe ecran caracterele de tabulare (introduse în text ca urmare a apăsării tastei 

Tab ), sub forma unor mici săgeţi (  ).  
 

Există două posibilităţi pentru a efectua această operaţie: 
 

A) Se alege Buton Office → Opţiuni Word → Afişare →  Tabulatori (Office Button → Word 

Options → Display →  Tab caracters) → OK  

 

 
 

B) Se activează butonul  din fila Pornire (Home). 
 

Exemplu: 

 
 
 

 Ştergerea unui caracter tab din document 
 

1. Se afişează marcajele pentru caracterele Tab (a se vedea aliniatul anterior). 

2. Se poziţionează punctul de inserţie (cursorul text) în faţă sau după marcajul Tab (care apare 

sub forma unei mici săgeţi) ce trebuie şters. 

3. Se şterge marcajul prin acţionarea tastei Delete sau Backspace. 

 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 57 

 

 Definirea tabulatorilor: La stânga, La centru, La dreapta, Zecimal 
 

Definirea stopurilor de tabulare presupune selectarea tipului de aliniere şi a poziţiei pentru 

fiecare tabulator care se doreşte a fi folosit (eventual şi a unui caracter de umplere = “indicator”). 
 

1. Se selectează paragraful pentru care se va defini un tabulator (sau mai mulţi). 

2. Se alege din fila Pornire → grupul Paragraf,  Paragraf →  (Home → 

Paragraph, butonul Paragraph → ). Va apărea următoarea casetă de dialog:  

 
 

- în caseta Poziţionare tabulator (Tab stop position), se introduce poziţia la care se va pune 

un nou stop de tabulare (o valoare de pe riglă); 

- în zona Aliniere (Alignment), se selectează alinierea dorită pentru textul scris în dreptul 

tabulatorului; alegerea La bară (Bar) adaugă o bară verticală în poziţia stopului de tabulare; 

-în zona Indicator (Leader), se face clic pe opţiunea dorită (caracterul de umplere care să 

preceadă textul din poziţia tabulatorului); 

- se face clic pe butonul Stabilire (Set); valoarea noului stop de tabulare va apărea în lista din 

zona Poziţionare tabulator (Tab stop position). 

3. Se repetă subpunctele de la pasul 2 pentru a stabili şi alte stopuri de tabulare.  

4. După introducerea tuturor tabulatorilor se părăseşte caseta prin clic pe OK. 
 

Observaţie: Fiecare paragraf poate avea sau nu, definite propriile stopuri de tabulare. Pe riglă vor fi 

vizualizaţi tabulatorii adăugaţi: 
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 Utilizarea tabulatorilor: La stânga, La centru, La dreapta, Zecimal 
 

1. Se selectează paragraful (sau paragrafele) pentru care se doreşte definirea unor stopuri de 

tabulare (tabulatori). 

2. Se definesc tabulatorii la stânga, la dreapta etc. - utilizăm caseta Tabulatori (Tabs). 

3. În document, se va apăsa tasta Tab înaintea introducerii fiecărui text ce trebuie să se alinieze 

la poziţia tabulatorului. 

4. Se va trece pe rândul următor prin apăsarea tastei Enter. 

5. Când s-a terminat textul scris cu tabulatori, se poziţionează punctul de inserţie pe un rând gol 

(sub listă) şi se elimină tabulatorii cu clic pe Golire totală (Clear All) în fereastra Tabulatori 

(Tabs). 
 

Exemplu: 
 

 
 

Se poate deplasa o coloană întreagă din textul scris cu tabulatori dacă se selectează tot textul, 

se poziţionează săgeata mouse-ului pe rigla orizontală, pe tabulatorul corespunzător coloanei 

ce se doreşte a fi mutată şi se execută glisare şi fixare în direcţia dorită. În figura următoare au 

fost modificate toate stopurile de tabulare. 
 

 
 

Dacă se selectează tot textul ce conţine tabulatori modificarea se va face pentru o întreagă 

coloană. Dacă punctul de inserţie se află pe un rând al textului modificarea se va face doar 

pentru rândul respectiv. 
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 Modificarea poziţiilor de tabulare 
 

1. Se selectează paragraful/paragrafele în care dorim să modificăm un tabulator. 

2. Se alege Pornire → grupul Paragraf,  →  (Home → 

Paragraph,  → ). 

3. În fereastra Tabulatori (Tabs) se selectează stopul de tabulare din listă (valoarea lui) şi se 

modifică opţiunile de aliniere sau alegerile făcute în zona Indicator (Leader) apoi se 

efectuează clic pe Stabilire (Set). 

4. Se repetă pasul 3 de câte ori este necesar. 

5. Se închide caseta prin clic pe butonul OK. 

 

 Eliminarea (ştergerea) unui Stop de tabulare 
 

1. Se selectează paragraful (sau paragrafele) în care dorim să eliminăm un stop de tabulare 

(tabulator). 

2. Se alege fila Pornire → grupul Paragraf,  →  (Home → 

Paragraph,  → ). 

3. În fereastra Tabulatori (Tabs) se selectează stopul de tabulare din listă (valoarea lui) şi se 

execută clic pe butonul Golire (Clear). Prin clic pe butonul Golire totală (Clear All) se 

elimină toţi tabulatorii. 

4. Se repetă pasul 3 de câte ori este necesar. 

5. Se închide caseta prin clic pe butonul OK.  

După închiderea casetei, stopurile de tabulare eliminate dispar şi de pe riglă. 

 

Observaţie:  Tabulatorii se pot adăuga direct  pe riglă  din caseta cu tabulatori. Caseta cu tabulatori se 

află la intersecţia dintre rigla orizontală şi cea verticală.  

 
 

Pentru a selecta un tip de tabulator se dă clic pe această casetă de mai multe ori până 

apare tabulatorul dorit. 

După ce apare tabulatorul dorit, se execută clic pe riglă în locul în care se doreşte a fi 

amplasat.  

Tabulatorul se repoziţionează pe riglă prin procedeul de glisare şi fixare (drag and 

drop).  

Tabulatorul se elimină de pe riglă prin procedeul de glisare şi fixare (drag and drop) în 

exteriorul riglei. 
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3.3.2.8. Introducerea şi ştergerea marcatorilor (bullets) şi a numerotărilor 
(numbers) pentru o listă simplă 

În Microsoft Word se pot crea automat liste cu marcatori sau liste numerotate în timpul tastării 

textului, sau se pot adăuga rapid marcatori sau numere la liniile de text deja introduse. Un marcator sau 

o numerotare va apărea în faţa primului rând din paragraf. 

 
 

 Adăugarea de marcatori sau numerotări la textul existent 
 

1. Se selectează textul ce urmează a fi marcat sau numerotat. 

2. Din fila Pornire → grupul Paragraf (Home → grupul Paragraph) se activează prin clic, 

după preferinţă, unul dintre butoanele  Marcatori (Bullets), respectiv  Numerotare 

(Numbering). 

 
 

Listele puse la dispoziţie prin utilizarea acestor butoane conţin un anumit marcator (sau un 

anumit tip de numerotare) şi folosesc un spaţiu prestabilit între marcator (sau număr) şi textul 

care urmează. 

 

 Liste cu marcatori sau numerotare, introduse în timpul tastării 
 

1. Se activează unul dintre butoanele  Marcatori (Bullets) sau  Numerotare 

(Numbering) înainte de a introduce elementele listei.  

2. Se introduce apoi textul, tastând Enter după fiecare element din listă.  

3. După ce se termină de introdus lista, se dezactivează butonul corespunzător:  sau  .   

 

 Ştergerea (eliminarea) marcatorilor sau a numerotărilor din faţa textului 
 

1. Se selectează textul de la care se elimină marcatorii sau numerotarea. 

2. Se dezactivează prin clic butonul corespunzător tipului de listă  respectiv  sau din 

lista asociată butonului se alege Fără (None). 
 

mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\Office10\1048\wdmain10.chm::/html/wodecNumberListsAndHeadings.htm##
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Observaţie:  

- Se pot crea automat în timpul tastării liste cu marcatori sau numerotare şi prin altă 

metodă: 

1.  Se poziţionează punctul de inserţie la începutul unui rând nou. Se parcurge calea: fila 

Pornire → grupul Paragraf  (Home grupul Paragraph), se selectează din lista  

Marcatori (Bullets) sau  Numerotare (Numbering) oferta dorită.  

2.  Se introduce textul dorit pentru un element din listă. Se apasă Enter după fiecare 

element al listei (pentru a introduce următorul element în listă). Următorul număr sau 

marcator se va insera automat. 

3.  Pentru a termina lista, se apasă  de două ori Enter, sau o singură dată tasta Backspace 

(pentru a şterge ultimul marcator sau ultimul număr din listă).  

 

- Se poate continua o listă numerotată creată anterior (după care a fost introdus text) în 

document, dacă se selectează  şi apoi în lista Opţiuni AutoCorecţie se dă clic pe 

Continuare numerotare  (lista AutoCorect Options  → Continue Numbering ). 

Exemplu:  

 
 

Se poate alege şi următoarea variantă:  
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- De asemenea, se poate folosi în cadrul unui document acelaşi model de listă, dar cu 

numerotarea reluată dacă se selectează Repornire numerotare (Restart Numbering).  

Exemplu: 

 
 

 

Notă 

În Word se pot crea liste subordonate  Listă multinivel (Multilevel List). Se activează 

butonul Numerotare (Numbering). Se introduc pe rând elementele listei astfel: pentru a păstra 

acelaşi nivel cu cel al elementului precedent se apasă Enter, pentru trecerea pe un nivel inferior 

se apasă tasta Tab sau butonul  Mărire indent (Increase Indent) iar pentru revenirea la un 

nivel superior se apasă combinaţia de taste Shift+ Tab sau butonul  Micşorare indent 

(Decrease Indent). 

Ieşirea din listă: se ajunge la primul nivel şi apoi se apasă tasta Backspace.  

 

3.3.2.9. Schimbarea stilului marcatorilor şi numerotărilor folosind 
opţiunile standard 

 

Listele puse la dispoziţie prin utilizarea butoanelor Numerotare (Numbering) şi Marcatori 

(Bullets) din grupul Paragraf (Paragraph) conţin un anumit tip de marcator şi model de numerotare. 
 

Utilizatorul poate opta pentru alt caracter de  marcare (stil de marcator) sau pentru un alt stil de 

numerotare. 

 

 Schimbarea stilului de marcatori sau numerotări într-o listă 

 

1. Se selectează lista cu marcatori (sau lista numerotată) ce se va modifica. 

2. Se alege din lista Marcatori → Definire marcator nou (Bullets → Define New Bullet) sau 

din Numerotare → Definire format de număr nou  (Numbering → Define New Number 

Format) varianta dorită, situaţie în care se va deschide una dintre casetele de mai jos:  
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Se defineşte un marcator nou sau un stil nou de numerotare astfel: se face clic pe Simbol 

(Symbol) sau Imagine (Picture)  pentru modificarea listei marcate, sau se alege din lista Stil 

număr (Number Style)  un stil de numerotare şi din butonul Font, fontul utilizat pentru a modifica 

liste numerotate. Caseta se închide prin clic pe butonul OK. 

 

3.3.2.10.  Adăugarea de borduri (chenare) şi umbriri unui paragraf 

Există situaţii în care se doreşte evidenţierea unui anumit text. Pentru aceasta se pot utiliza font-

uri diferite de restul textului, o altă mărime de font, o altă culoare a caracterelor, se pot folosi caractere 

aldine, cursive sau subliniate. Se pot utiliza liste numerotate sau marcate, se pot indenta paragrafe, 

spaţia rânduri şi paragrafe. În afară de acestea mai există şi alte posibilităţi cum ar fi  adăugarea unui 

chenar, a unei umbre şi/sau a unei culori de fundal unui paragraf. 

 

 Adăugarea unei borduri prestabilite unuia sau mai multor paragrafe 
 

 

1. Se selectează paragraful (paragrafele) la care se va aplica bordura (chenarul). 

2. Din fila Pornire, grupul Paragraf (Home, grupul Paragraph) se alege din lista cu modele de 

borduri varianta dorită: 
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 Adăugarea unei borduri personalizate unui paragraf 
 

1. Se selectează paragraful/ paragrafele la care se va aplica bordura. 

2. Se alege fila Pornire → grupul Paragraf, lista de borduri → Borduri şi umbrire (Home → 

grupul Paragraph, lista de borduri → Borders and Shading). 

3. În fila Borduri (Borders) se alege:  
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-  modelul de chenar din lista Setare (Setting), sau varianta Fără (None) pentru a elimina 

chenarul existent la un paragraf; 

-  stilul de linie din lista Stil (Style);  

-  culoarea din lista Culoare (Color)  

-  grosimea de linie din lista Lăţime (Width); 

-  Paragraf (Paragraph) din lista Se aplică la: (Apply to:).  

Pentru a adăuga sau elimina o anumită linie din chenar se poate executa clic pe butoanele din 

secţiunea Examinare (Preview). 

4. Se închide caseta de dialog prin clic pe butonul OK 

 

 

Notă 

Dacă se adaugă bordură la paragrafe atunci se poate modifica distanţa dintre chenar şi text astfel: 

clic pe butonul Opţiuni…  (Options) şi în caseta de dialog Opţiuni pentru Bordură şi umbrire 

(Borders and Shading Options) se stabilesc distanţele pentru Sus (Top), Jos (Bottom), Stânga 

(Left), Dreapta (Right). 

 

 
 

 

 Adăugarea unei umbriri unui paragraf 
 

1. Se selectează paragraful la care se va aplica umbrirea. 

2. Se alege Pornire → grupul Paragraf →  lista de borduri → Borduri şi umbrire, fila Umbrire 

(Home → grupul Paragraph → lista de borduri → Borders and Shading, fila Shading): 
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Din fila Umbrire (Shading), lista Umplere (Fill) a casetei de dialog se adaugă sau se elimină 

culori de fundal. Din lista Se aplică la: (Apply to:) se alege Paragraf (Paragraph).  

3. Se închide caseta de dialog prin clic pe butonul OK. 

 

Exemplu: 

 

 
 

 

Notă 

Se poate aplica o umbrire (culoare de fundal) unui paragraf şi prin acţionarea butonului  

Umbrire (Shading) din grupul Paragraf fila Pornire (Paragraph fila Home). 

 

 

3.3.3. Formatarea paginilor 

3.3.3.1. Schimbarea dimensiunii hârtiei şi a orientării 

Utilizatorul poate stabili dimensiunea foii de hârtie, orientarea  paginilor din document, precum 

şi marginile libere ce se vor lăsa de la marginea foii fizice până la textul din foaie. În vederea 

imprimării documentului, se stabilesc marginile libere (sus, jos, stânga, dreapta) ce se vor lăsa de la 

marginea foii fizice până la textul din foaie, precum şi dimensiunea spaţiului suplimentar ce se va 

adăuga marginii în scopul îndosarierii.  
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 Schimbarea mărimii hârtiei, a orientării şi a marginilor: 
 

 Dimensiunea hârtiei - se alege fila Aspect pagină → grupul Iniţializare pagină → 

Dimensiune (Page Layout → Page Setup → Size). Se selectează una dintre oferte.  
 

Dacă varianta dvs. nu se află printre oferte atunci alegeţi Mai multe dimensiuni de hârtie 

(More Paper Size) situaţie în care va fi deschisă caseta de dialog Iniţializare pagină (Page 

Setup). Efectuaţi clic pe fila Hârtie (Paper): 

 

 
 

-  Dimensiunea foii de hârtie se alege din caseta Dimensiune hârtie (Paper size).  

-  În zona Examinare (Preview) în caseta Se aplică la (Apply to) se alege varianta dorită 

(porţiunea din document căreia i se aplică setarea respectivă). Dacă utilizatorul optează  

pentru o dimensiune de pagină personalizată numai pentru o anumită parte a 

documentului atunci se poziţionează  punctul de inserţie la începutul paginii care se 

doreşte a fi modificată, se aleg setările corespunzătoare şi în caseta Se aplică la (Apply to) 

se alege De la acest punct înainte (This Point Forward). Dacă anterior a fost selectată o 

anumită zonă de text atunci putem alege varianta Text selectat (Selected text). 
 

 Orientarea paginilor - se stabileşte din fila Aspect pagină → grupul Iniţializare pagină → 

Orientare → Portret sau Vedere (Page Layout → grupul Page Setup → Orientation→ 

Portrait sau Landscape): 

 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 68 

 

 
 

Orientarea paginilor mai poate fi stabilită din caseta de dialog, dacă se parcurge calea: Aspect 

pagină → grupul Iniţializare pagină → lansatorul casetei de dialog Iniţializare pagină → 

fila Margini (Page Layout → grupul Page Setup → butonul Page Setup → fila Margins). În 

zona Orientare (Orientation) se alege una dintre variantele: Tip portret (Portrait) sau Tip 

vedere (Landscape): 
 

 
 

 Marginile paginilor se stabilesc din fila Aspect pagină → grupul Iniţializare pagină → lista 

Margini (Page Layout → Page Setup →Margins). Se alege una dintre oferte. 

 

Dacă doriţi să stabiliţi anumite valori pentru margini atunci alegeţi din listă Margini 

particularizate (Custom Margins) situaţie în care se va afişa caseta de dialog Iniţializare 

pagină (Page Setup) cu fila Margini (Margins) prezentată anterior. 

-  În zona Margini (Margins) se stabilesc marginile, care se lasă pentru foaia de hârtie, în 

casetele Sus (Top), Jos (Bottom), Stânga (Left), Dreapta (Right).  
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-  În caseta Pt. îndoire (Gutter) se introduce dimensiunea spaţiului suplimentar pe care 

dorim să îl adăugăm marginii, în scopul îndosarierii (spaţiu pentru îndosariere). În zona 

Examinare (Preview) se vede aspectul ajustărilor din document. De asemenea, din lista 

Poziţie îndoitură (Gutter position) se poate alege unde să fie poziţionat acest spaţiu.  

-  În caseta Se aplică la: (Apply to:) se alege porţiunea din document pentru care se doreşte 

aplicarea setării curente din fereastra Iniţializare pagină (Page Setup). 

3.3.3.2. Inserarea, ştergerea unui marcaj de întrerupere-pagină (page 
break)  

 

Uneori se doreşte ca textul, ce urmează a fi introdus în continuare, să fie scris pe o pagină nouă 

chiar dacă pagina curentă nu a fost completată cu text. Cu alte cuvinte se doreşte să se termine pagina 

curentă la o anumită poziţie şi să se facă saltul la o pagină nouă. 

O posibilitate ar fi să se apese tasta Enter, adică să se introducă rânduri goale până când se 

ajunge în pagina următoare. Mai indicat este să se utilizeze comanda Sfârşit de pagină (Page break). 

 

 Inserarea manuală a sfârşitului de pagină 

1. Se poziţionează punctul de inserţie în locul în care se doreşte să înceapă o pagină nouă. 

2. Se alege fila Inserare → grupul Pagini → Sfârşit de pagină (Insert → grupul Pages → Page 

Break). 

 

Observaţie:  - Se poate introduce un sfârşit de pagină şi dacă folosim combinaţia de taste Ctrl+Enter. 

- Pentru a introduce o pagină albă în faţa tuturor paginilor cu text se apasă  Ctrl+Home şi 

apoi Ctrl+Enter. 

- Pentru a introduce o pagină albă în poziţia cursorului alegeţi fila Inserare → grupul 

Pagini → Pagină necompletată (Insert → grupul Pages → Blank Page). 

 

 Ştergerea unui sfârşit de pagină introdus manual 
 

1. Se face clic pe butonul Afişare totală (Show/Hide) aflat în fila Pornire (Home) pentru a 

vizualiza caracterele netipăribile. 

2. Se selectează marcajul ...Sfârşitul de pagină... (.......Page Break.......) ce urmează a fi şters: 

 
 

3. Se apasă tasta Delete.  
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3.3.3.3. Adăugarea, modificarea unui text în antet şi subsol 

În paginile lucrării create în Word se pot adăuga anteturi şi subsoluri. Aceste elemente se tipăresc 

în mod obişnuit pe toate paginile documentului. De obicei în una din aceste zone se face numerotarea 

automată a paginilor documentului. 

Alegerea Header respectiv Footer va marca zonele de antet respectiv subsol din pagină cu linii 

întrerupte şi va activa aceste zone pentru a se putea lucra în ele. Textul din afara zonelor de antet şi 

subsol se va dezactiva. 

 

 Adăugare Antet şi Subsol (Header and Footer) 
 

1. Se alege fila Inserare → grupul Antet şi subsol → Antet respectiv Subsol (Insert → grupul 

Header and Footer → Header respectiv Footer) şi se dă clic pe una dintre oferte. 

2. Se va activa zona de Antet (Header) sau Subsol (Footer) care va fi marcată cu linie întreruptă 

şi va apărea tab-ul Antet şi subsol (Header & Footer Tools): 

 

 

Se tastează textul pentru antet şi se formatează ca orice text.  

3. Comutarea între antet şi subsol se face cu clic în zona respectivă sau prin clic pe butoanele 

Salt la antet (Go to Header) respectiv Salt la subsol (Go to Footer) din fila Instrumente 

Antet şi subsol Proiectare, grupul Navigare (Header & Footer Tools Design, grupul 

Navigation).  

4. Când se finalizează crearea sau modificarea antetului respectiv a subsolului se revine în 

document cu clic pe butonul  Închidere antet şi subsol din fila Instrumente Antet şi subsol  

Proiectare (Close Header and Footer din tab-ul Header & Footer Tools Design) sau se 

execută dublu-clic în zona de lucru. 
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 Modificarea ulterioară a antetului şi subsolului: 
 

1. Se parcurge calea Inserare → grupul Antet şi subsol → Antet →  Editare antet respectiv 

Subsol → Editare subsol (Insert → grupul Header & Footer → Header → Edit Header 

respectiv Footer → Edit Footer) sau se execută dublu clic în zona de antet/subsol.  

2. Se editează textul din zonele  Antet (Header) respectiv Subsol (Footer). 

3. Se revine în document prin clic pe butonul Închidere antet şi subsol (Close Header and 

Footer) din tab-ul Header & Footer Tools sau se execută dublu clic în zona de lucru. 
 

Notă 
 

În tab-ul Instrumente Antet şi subsol Proiectare (Header & Footer Tools Design) dacă se 

bifează caseta Paginile pare diferă de cele impare (Different odd and even) se poate crea un 

antet sau subsol pentru paginile cu numerotare pară şi un antet sau un subsol diferit pentru 

paginile cu numerotare impară. 

 

 
Antetul sau subsolul introdus pe prima pagină impară va apărea pe toate paginile impare, iar cel 

introdus pe prima pagină pară va apărea pe toate paginile pare. 

Bifarea casetei Prima pagină diferită (Diferent first page) permite să fie creat un antet sau un 

subsol diferit pentru prima pagină. 

În casetele Antet de sus  (Header from Top), Subsol de jos (Footer from Bottom) se introduce 

distanţa care se lasă între marginea paginii de hârtie şi marginea superioară a antetului sau 

marginea inferioară a subsolului.  
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3.3.3.4. Adăugarea unor câmpuri în antet şi subsol: data, oră etc. 

Se poate adăuga în antet şi subsol text sau grafică, se pot numerota paginile documentului, insera 

data şi ora curente, numele documentului şi locul unde se află acesta pe disc, precum şi alte informaţii.  

 

 Adăugarea unor câmpuri în antet şi subsol se face parcurgând paşii: 
 

1. Se activează zona antet/ subsol.  

2. Se alege din fila Instrumente Antet şi subsol Proiectare, grupul Inserare (Header & Footer 

Tools Design → grupul Insert) butonul corespunzător: 

 
 

3.3.3.5. Aplicarea automată a numărului de pagină unui document 

Microsoft Word oferă două modalităţi de numerotare automată a paginilor. Numărul de pagină 

este un câmp care se pune de obicei în antet sau subsol. 
 

 Adăugarea unei numerotări standard paginilor 
 

1. Se alege fila Inserare (Insert) sau Instrumente Antet şi subsol Proiectare, din grupul Antet 

şi subsol  → Număr de pagină (Insert sau Header & Footer Tools Design → grupul Header 

& Footer → Page Numbers). Fila Instrumente Antet şi subsol Proiectare (Header & Footer 

Tools Design) apare numai dacă punctul de inserare se află în zona de antet sau subsol. 
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2. Din lista care apare se indică dacă numerele de pagină să se imprime în antet, în subsol, la 

marginea paginii sau în poziţia curentă a cursorului text. Pentru eliminarea numerotării se 

alege Eliminare numere pagină (Remove Page Numbers). 

3. Se pot stabili eventual alte opţiuni privitoare la formatul numerotării paginilor şi la numărul 

cu care începe numerotarea paginilor cu clic pe Formatare numere de pagină (Format Page 

Numbers). 

 
 

 

 

 

Ce aţi învăţat în acest capitol? 
 

 Cum se formatează un document pentru a răspunde cerinţelor grafice şi de 

conţinut ale proiectantului documentului:  

- Stabilirea fontului şi a dimensiunii acestuia. 

- Utilizarea culorilor. 

- Aplicarea „stilurilor”. 

- Formatarea paragrafelor. 

- Spaţierea şi utilizarea tabulatorilor. 

 Cum se parametrizează pagina pentru un document: 

- Stabilirea dimensiunilor şi a orientării hârtiei. 

- Stabilirea marginilor. 

- Plasarea informaţiilor de tip antet, subsol, paginare. 
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3.4. Obiecte 

În documentele create cu Word se pot introduce alături de text şi diferite obiecte (create sau 

existente într-un fişier) cum ar fi: tabele, imagini, diagrame, obiecte desenate etc.  

3.4.1. Tabele 

3.4.1.1. Crearea unui tabel standard 

O modalitate simplă de organizare şi prezentare a textului şi a graficii o reprezintă tabelele. Un 

tabel este alcătuit din rânduri şi coloane de celule. Celulele pot conţine text, numere, reprezentări 

grafice sau formule de calcul. Un tabel poate fi creat în mai multe moduri.  
 

  Crearea unui tabel: 
 

1. Se poziţionează punctul de inserare în locul în care se doreşte să apară tabelul. 

2. Se alege fila Inserare → grupul Tabele→ Tabel ( Insert → grupul Tables → Table). 

 

3. Se selectează un număr de rânduri şi coloane de pătrăţele pentru a indica dimensiunea 

tabelului. Se poate alege Inserare ca tabel (Insert Table) şi să se stabilească aceste opţiuni în 

caseta de dialog următoare: 

 

În zona Dimensiune tabel (Table size), se stabilesc numărul de coloane şi de rânduri ale 

viitorului tabel.  



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 75 

 

În zona Regim de potrivire automată (AutoFit behavior), se aleg opţiunile pentru ajustarea 

lăţimii coloanelor. 

Ieşirea din casetă se face cu clic pe butonul OK. 

3.4.1.2. Introducerea şi editarea informaţiilor într-un tabel 

 Introducerea informaţiilor într-un tabel 
 

După ce tabelul a fost creat, se pot introduce date în celulele acestuia. Pentru aceasta este necesar 

să ne poziţionăm mai înainte în celula în care dorim să introducem informaţia.  

Poziţionarea într-o celulă se poate face în mai multe moduri:  

- Clic în celulă. 

- Utilizând tastele săgeţi. 

- Utilizând tasta Tab  se trece dintr-o celulă în alta spre dreapta. 

- Shift+Tab  se trece dintr-o celulă în alta spre stânga. 

 

Exemplu: 

 
 

 Editarea informaţiilor într-un tabel 
 

Pentru a edita o celulă a unui tabel, ne poziţionăm în celula respectivă şi apoi se editează 

conţinutul în mod obişnuit. Pentru poziţionarea într-o celulă e suficient să se execute clic în celula 

respectivă.  
 

-  Fiecare celulă a tabelului poate fi formatată separat. Orice acţiune aplicabilă textului dintr-un 

paragraf este valabilă şi pentru textul dintr-o celulă. 
 

-  Pentru lucrul rapid cu tabele se poate utiliza fila Instrumente tabel Proiectare şi Instrumente 

tabel Aspect (Table Tools Design şi Table Tools Layout). 

Textul dintr-o celulă poate avea orice aliniere din lista asociată butoanelor de alinieri: 
 

 

-  Se poate modifica orientarea textului dintr-o celulă dacă se foloseşte butonul  Orientare 

text (Text Direction).  
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3.4.1.3. Selectarea rândurilor, coloanelor, celulelor şi a întregului tabel 

În cadrul unui tabel se trece dintr-o celulă în alta spre dreapta apăsând tasta Tab. Cu combinaţia 

de taste Shift+Tab se face deplasare spre stânga (se pot folosi şi tastele săgeţi). Se poate adăuga un 

rând nou de celule în tabel dacă se apasă tasta Tab atunci când punctul de inserţie se află în ultima 

celulă a tabelului. 
 

Tabelul următor prezintă diverse moduri de selectare a unor regiuni din tabel: 

 

Pentru a selecta: Se efectuează acţiunea următoare: 

O celulă - Se deplasează mausul în marginea din stânga a celulei şi când se 

transformă într-o săgeată orientată spre dreapta se execută clic 

sau 

- Triplu clic în celulă 

Un rând - Se deplasează mouse-ul în marginea din stânga, în afara tabelului, 

se indică spre rând şi se efectuează clic 

Mai multe rânduri - Se selectează primul rând, se execută clic şi se glisează peste restul 

rândurilor pe care le dorim în selecţie. 

O coloană - Se poziţionează mouse-ul deasupra coloanei şi când cursorul se 

orientează către coloană se execută clic 

Mai multe coloane - Ca pentru mai multe rânduri  

sau 

- Pentru coloane adiacente, se selectează prima coloană, apoi se ţine 

apăsată tasta Shift şi se selectează ultima coloană 

Întregul tabel - tab-ul Tabel → Selectare→ Selectare tabel (Table Tools Layout→ 

Select → Select Table) 

sau 

- Clic pe butonul selecţie tabel din colţul de sus stânga-sus al 

tabelului  

 

3.4.1.4. Inserarea, ştergerea rândurilor şi a coloanelor 

Dacă se doreşte adăugarea de rânduri în tabel se selectează în tabel un număr de rânduri câte 

urmează a fi inserate şi se alege fila Instrumente Tabel Aspect → grupul Rânduri şi coloane → 

Inserare deasupra sau Inserare dedesubt (Table Tools Layout  → grupul Rows & Columns → Insert 

Above sau Insert Below). 
 

Pentru ştergerea rândurilor, se selectează rândurile care urmează a fi şterse şi se selectează fila 

Instrumente Tabel Aspect → grupul Rânduri şi coloane → Ştergere → Ştergere rânduri (Table 

Tools Layout → Delete → Delete Rows).  
 

Dacă se selectează o celulă în locul unui rând, se va alege Instrumente Tabel Aspect → grupul 

Rânduri şi coloane → Ştergere → Ştergere Celule (Table Tools Layout → Delete → Delete Cells) şi 

va apărea fereastra Ştergere celule (Delete Cells) din care se va alege cum se vor deplasa celulele 

rămase. 
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Pentru a şterge tot tabelul se alege Instrumente Tabel Aspect → grupul Rânduri şi coloane → 

Ştergere → Ştergere Tabel (Table Tools Layout → Delete → Delete Table). 
 

Notă   

Aşa cum s-au inserat şi s-au şters rândurile se pot insera şi şterge şi coloanele. 

Observaţie: - În situaţia în care un tabel a fost introdus imediat ce s-a deschis un document nou (adică 

deasupra lui nu exista text sau spaţiu liber) atunci, pentru a insera un rând de text deasupra 

tabelului, se executa clic în prima celulă din tabel şi din fila  Instrumente Tabel Aspect 

grupul Îmbinare (Table Tools Layout, grupul Merge) se alege comanda  Scindare tabel 

(Split Table). 

 

- Dintr-o celulă a unui tabel se pot crea mai multe celule executând clic în celula dorită şi 

selectând comanda Scindare celule (Split Cells) din tab-ul Tabel (Table Tools Layout). În 

fereastra care apare se alege numărul de rânduri şi coloane în care se împarte celula 

selectată. 

 
 

- Din mai multe celule alăturate se poate forma o singură celulă selectând celulele ce se 

doresc unite şi apoi selectând comanda Îmbinare celule (Merge Cells). 
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3.4.1.5. Modificarea lăţimii coloanei şi înălţimii rândului 

Atât lăţimile coloanelor cât şi înălţimile rândurilor pot fi modificate.  
 

 Cea mai simplă metodă de a ajusta o coloană sau un rând este de a deplasa punctul de inserţie 

la limita de jos a rândului sau la limita din dreapta a coloanei. Punctul de inserţie se va 

transforma într-o săgeată cu două capete, (pentru coloană , pentru rând ), care permite 

deplasarea marginilor, prin glisare şi fixare (drag and drop), în oricare din cele două direcţii 

posibile.  

Pentru a se afişa în riglă lăţimile coloanelor sau înălţimile rândurilor (în timp ce le 

modificăm dimensiunea) se ţine apăsată tasta ALT când se glisează marginile.  

 
 

 Alte metode care permit precizarea cu exactitate a dimensiunilor: 

 

Pentru a modifica lăţimea unei coloane la o anumită mărime 
 

1. Se  efectuează clic pe o celulă din coloană. 

2. Se alege Instrumente Tabel Aspect → grupul Tabel → Proprietăţi (Table Tools Layout → 

grupul Table → Properties). În caseta de dialog Proprietăţi tabel (Table Properties) se dă 

clic pe fila Coloană (Column). Se selectează opţiunile dorite.  
 

 

mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\Office10\1048\wdmain10.chm::/html/wddecChangeSizeOfTableOrPartsOfTable.htm##
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Pentru a modifica înălţimea unui rând la o anumită mărime 
 

1. Se efectuează clic pe o celulă din rând.  

2. Se alege Instrumente Tabel Aspect → grupul Tabel → Proprietăţi (Table Tools Layout → 

grupul Table → Properties), apoi fila Rând (Row). Se selectează opţiunile dorite.  
 

 

Pentru a face coloanele dintr-un tabel să se potrivească automat la conţinut 
 

1. Se execută clic într-o celulă din tabel. 

2. Se alege Instrumente Tabel Aspect → grupul Dimensiune celule → Potrivire automată → 

Conţinuturi cu Potrivire automată (Table Tools Layout → grupul Cell Size → AutoFit → 

AutoFit Contents).  

 
 

3.4.1.6. Modificarea chenarului 

Într-un tabel se pot schimba stilul, lăţimea şi culoarea bordurii (chenarului) uneia sau mai multor 

celule precum şi a întregului tabel.  
 

 Pentru aplicarea unei margini, se selectează celulele cărora urmează să li se aplice marginea, 

se alege Instrumente Tabel Proiectare → Borduri (Table Tools Design → Borders), se alege 

una dintre oferte.  

 

mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\Office10\1048\wdmain10.chm::/html/wddecChangeSizeOfTableOrPartsOfTable.htm##
mk:@MSITStore:C:\Program%20Files\Microsoft%20Office\Office10\1048\wdmain10.chm::/html/wddecChangeSizeOfTableOrPartsOfTable.htm##
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Dacă se alege oferta Borduri şi umbrire (Border and Shading) va apărea o casetă de dialog 

de unde se va selecta stilul de linie, grosimea şi culoarea care urmează a fi folosite şi apoi se 

efectuează clic pe tipul de margine dorit. 
 

 O altă variantă ar fi să se utilizeze grupul de comenzi Desenare borduri (Draw Borders) sau o 

ofertă din galeria Stiluri tabel (Table Styles) 

 

3.4.1.7. Adăugarea unei umbriri (culoare de fond) celulelor 

 Pentru a adăuga culori de fundal se selectează celulele, rândurile sau coloanele dorite şi se 

alege culoarea de fundal din lista asociată butonului  Umbrire din fila 

Proiectare, grupul Stiluri tabel (Shading din tab-ul Table Tools Design, grupul Table Styles).  

 O altă variantă: se selectează celulele, rândurile sau coloanele dorite şi se alege culoarea prin 

activarea butonului  aflat în fila Pornire → grupul Paragraf  (Home → grupul 

Paragraph).  

 

3.4.2. Grafică în documente text 

Într-un document Word se pot insera imagini (Picture), miniaturi (Clip Art), forme (Shapes), 

ilustraţii (Smart Art), diagrame (Chart), casete text (Text Box), text decorativ Word Art, obiecte 

(Object) etc. 

Toate acestea se află pe fila Inserare (Insert).  

 
 

3.4.2.1. Introducerea graficii într-un document 

 Introducerea unei miniaturi (ClipArt) 
 

Microsoft Word pune la dispoziţia utilizatorului o serie de miniaturi (ClipArt-uri). Acestea sunt 

picturi de dimensiuni mici organizate pe categorii.  
 

În document se poate introduce o miniatură dacă se alege: fila Inserare → grupul Ilustraţii, 

Miniatură (Insert → grupul Illustrations, ClipArt). Din panoul de activităţi Miniatură (Clip Art) ce va 

apărea în partea dreaptă se poate alege Organizare miniaturi (Organize Clips) care conţine colecţia 

Microsoft Office de miniaturi. Acestea sunt grupate pe mai multe categorii ce se deschid cu clic pe 

simbolul categoriei respective. Miniatura dorită poate fi glisată cu mouse-ul în document. De 

asemenea poate fi copiată dacă se face clic-dreapta pe miniatură şi din meniul contextual se alege 

opţiunea Copiere (Copy), se poziţionează apoi în document cursorul de inserare şi se face din nou clic-

dreapta şi se alege opţiunea Lipire (Paste).  



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 81 

 

 
 

Observaţii: Fereastra cu miniaturi rămâne deschisă după inserarea unei imagini dar este minimizată în 

bara de aplicaţii (Taskbar). 

 

 Introducerea unei imagini dintr-un fişier 
 

Imaginile sunt reprezentări grafice care se inserează dintr-un alt fişier. Aceste fişiere cu imagini 

se pot afla pe hard-disc, pe CD-uri, pe dischete etc.  

1. Se execută clic în poziţia în care se doreşte să fie inserată imaginea.  

2. Se alege Inserare → grupul Ilustraţii → Imagine (Insert → grupul Illustrations → Picture).  

 

3. Se selectează calea prin care se ajunge la imagine (pentru a localiza imaginea pe care dorim 

să o inserăm).  

4. Se selectează fişierul şi apoi se dă clic pe butonul Inserare (Insert) sau dublu clic pe fişierul 

imagine.  
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 Introducerea unei diagrame (grafic, Chart) 
 

Se alege fila Inserare → grupul Ilustraţii → Diagramă (Insert → grupul Illustrations → Chart) 

→ se alege modelul de diagramă → OK.  Se va afişa o diagramă (grafic) şi o foaie de calcul tabelar în 

Microsoft Excel ce conţine date pentru exemplificare.  

 

 
 

Pentru a înlocui datele afişate se efectuează clic într-o celulă din foaia de calcul şi apoi se 

tastează textul sau numărul dorit (repetăm operaţia până introducem toate datele). Pentru a reveni în 

documentul Word, se închide aplicaţia Excel.  

 

Exemplu: 

0

2

4

6

Mere Nuci Portocale Struguri

Mai

Iunie

Iulie

 
 

Datele din diagramă pot fi oricând modificate. După ce foaia de calcul a fost închisă poate fi 

reafişată dacă se execută clic pe diagramă şi apoi pe Instrumente diagramă Proiectare → grupul Date 

→ Editare date (Chart Tools Design →  grupul Data → Edit Data). Tot din fila Proiectare (Design) 

se pot aplica diferite formatări diagramei. 
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 Casete Text (Text Box)  
 

În aplicaţia Word se pot folosi casete de text pentru poziţionarea textului oriunde în pagină. O 

casetă text permite rotirea textului, aplicarea unei culori de fundal, bordură etc. O casetă text poate fi 

de formă dreptunghiulară, circulară sau de orice formă care reprezintă un contur închis.   

Pentru a construi o casetă text se alege: fila Inserare → grupul Text → Casetă text (Insert → 

grupul Text → Text Box). Se alege prin clic una dintre oferte sau pentru a desena manual caseta se 

alege Casetă text desenare (Draw Text Box) situaţie în care cursorul mouse-ului se transformă în cruce 

(se execută clic în locul în care dorim introducerea casetei şi se glisează mouse-ul în direcţia dorită 

până se stabileşte dimensiunea acesteia). Caseta text va avea în interior cursor de scriere. Textul se 

introduce şi se formatează ca orice text. Caseta text se încadrează în textul din pagină selectând-o şi 

alegând Încadrare text (Text Wrapping) din tab-ul Instrumente casetă text Format, grupul Aranjare  

(TextBox Tools Format, grupul Arrange).  

 

 

 

Din fila Instrumente casetă text Format (TextBox Tools Format) se pot stabili culori şi grosimi 

de linii pentru contur sau culoarea de fundal. Textul dintr-o casetă text poate avea orientări diferite 

dacă se selectează caseta text şi se alege Orientare text (Text Direction). Pot fi aplicate Efecte 3D (3-D 

Effects) şi alte formatări. De asemenea poate fi modificată forma casetei text Modificare formă 

(Change Shape). 

Dacă se execută clic-dreapta în interiorul casetei text atunci apare un meniu de context referitor 

la conţinutul (informaţia) casetei, iar dacă  se dă clic-dreapta pe chenarul casetei meniul de context se 

referă chiar la caseta de text. 

Caseta de text se poate şterge rapid dacă se selectează cu clic pe marginea ei şi se apasă tasta 

Delete. 

 

 Text decorativ WordArt 

 

Textul decorativ se utilizează pentru secvenţe scurte de text. Se introduce astfel: se alege fila 

Inserare →grupul Text → Word Art (Insert → grupul Text → Word Art) → clic pe imaginea uneia 

dintre oferte → se tastează textul → OK. 

 

Exemplu: 
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 Forme 

 

Într-un document Word se pot introduce obiecte desenate folosind instrumentele din lista 

Forme (Shapes). Se alege Inserare  → grupul Ilustraţii → Forme (Insert → grupul Illustrations → 

Shapes). 

 

Pentru a desena o formă se alege prin clic una dintre variante, se 

efectuează clic în pagină şi se glisează mouse-ul pentru a stabili 

dimensiunea formei. 

 

Dacă se doreşte desenarea de forme geometrice regulate se poate 

ţine apăsată  tasta Shift în timpul desenării. 

 

Orice obiect desenat se selectează cu clic pe el. 

 

Exemple: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Odată selectat, un obiect poate căpăta o culoare de fundal dacă se alege din fila Instrumente de 

desen Format (Drawing Tools Format) culoarea din lista asociată butonului Umplere formă 

(ShapeFill). Linia de contur se modifică dacă se face o alegere din lista Contur formă (Shape Outline). 

Punctul colorat în verde care apare pe unele obiecte se numeşte punct de rotaţie şi permite rotirea 

obiectului prin glisare şi fixare, iar punctele galbene se numesc puncte active şi modifică înclinarea 

obiectului selectat.  

Pentru a selecta mai multe obiecte se ţine tasta Shift apăsată în timpul selecţiei.  

Obiectele selectate pot fi grupate alegând fila Instrumente de desen Format → grupul Aranjare 

→ Grupare → Grupare (Drawing Tools Format → grupul Arrange → Group → Group). Obiectele 

grupate se vor comporta ca unul singur. Degruparea se realizează dacă se selectează grupul şi din 

meniul butonului Grupare (Group) se alege Anulare grupare (Ungroup). 
 

Obiectele se pot aşeza unele peste altele. Pentru a modifica ordinea de afişare a obiectelor 

suprapuse din meniul butonului Aducere în prim plan (Bring to Front) şi  Trimitere în ultimul plan 

(Send to Back) alegem varianta dorită.  
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Când se creează desene putem lucra cu pânza de desen afişată sau nu. Aceasta se afişează sau se 

ascunde dacă parcurgeţi calea: Buton Office → Opţiuni Word → Complex → zona Opţiuni de editare 

(Office Button → Word Options → Advanced → zona Editing options) se bifează sau nu caseta Se 

creează automat pânza de desen la inserarea formelor automate (Automatically create drawing 

canvas when inserting AutoShapes) → OK. O pânză de desen vă ajută să aranjaţi obiectele şi imaginile 

desenate şi să le deplasaţi uşor ca o unitate. 

 

3.4.2.2. Selectarea graficii dintr-un document 

O imagine, o miniatură, o casetă text se selectează astfel: se plasează cursorul mouse-ului pe 

obiect şi se execută clic. Obiectul selectat are afişat în jurul său un cadru cu opt pătrate mici la colţuri 

şi în mijlocul laturilor (ghidaje de dimensionare). 

 

Observaţie:  Pentru o formă inserată în text se poate alege stilul de încadrare a imaginii respective în 

text. Pentru aceasta se selectează obiectul (clic pe el) şi se alege fila Instrumente de 

Desen Format → grupul Aranjare → Încadrare text (Drawing Tools Format → grupul 

Arrange → Text Wrapping). 

 
 

-  În linie cu textul (In line with Text) - Plasează obiectul în linia de text în poziţia punctului de 

inserare. Obiectul rămâne în acelaşi plan cu textul.  

-  Pătrat (Square) - Încadrează textul în jurul tuturor laturilor casetei pătrate de delimitare 

pentru obiectul selectat 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale 

Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării procesoarelor de texte; aplicaţia WORD din Microsoft Office 

Pag. 86 

 

-  Strâns (Tight) - Încadrează strâns textul în jurul marginilor imaginii curente (în loc să îl 

aranjeze în jurul chenarului dreptunghiular care înconjoară obiectul). După ce aţi făcut clic pe 

Strâns (Tight) şi apoi pe OK, aveţi posibilitatea să ajustaţi perimetrul punctat al încadrării, 

făcând clic pe butonul Încadrare text (Text Wrapping) din fila Instrumente de Desen 

Format → grupul Aranjare → (Drawing Tools Format → grupul Arrange), apoi clic pe 

Editare puncte de încadrare (Edit Wrap Points). Glisaţi linia punctată sau ghidajele de 

dimensionare pentru a da o nouă formă perimetrului de încadrare. 

-  În spatele textului  (Behind text) - Elimină încadrarea obiectului în text şi plasează obiectul 

în document, în spatele textului. Obiectul este mobil în propriul său plan. Mutaţi obiectul în 

faţa sau în spatele textului, în faţa sau în spatele altor obiecte, utilizând comenzile Ordine 

(Order) din meniul contextual al obiectului (clic-dreapta pe obiect). 

-  În faţa textului  (In front of text) - Elimină încadrarea obiectului în text şi plasează obiectul 

în document, în faţa textului. Obiectul poate ascunde secvenţe de text care astfel nu mai sunt 

vizibile. Obiectul este mobil în propriul său plan.  

-  Sus şi jos (Top and Bottom) - Plasează obiectul în punctul de inserare într-o linie de text în 

document. Obiectul rămâne singur pe rând. 

-  Printre (Through) → Textul încadrează obiectul pe toate laturile urmărind forma obiectului. 

 

Exemplu: 

 
 

3.4.2.3. Ştergerea unei miniaturi, imagini, diagrame 

Se selectează obiectul care se va şterge, (clic pe  miniatură, imagine, diagramă) apoi se apasă 

tasta Delete sau Backspace. 

 

3.4.2.4. Editarea graficii dintr-un document 

 Redimensionare folosind mouse-ul: 

1. Se selectează obiectul prin clic pe el. 

2. Se poziţionează indicatorul mouse-ului peste unul din ghidajele de redimensionare care apar 

(pentru a se transforma într-o săgeată dublă). 

3. Se glisează ghidajul de dimensionare până când obiectul ajunge la forma şi dimensiunea 

dorită.  

Pentru a muta un obiect glisaţi-l cu mouse-ul în poziţia dorită. 

Alte operaţii de editare se găsesc în filele Instrumente de Desen Format (Drawing Tools 

Format), Instrumente Imagine Format (Picture Tools Format) etc. în funcţie de elementul selectat. 
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Ce aţi învăţat în acest capitol? 
 

 Cum se creează tabelele în Word şi editarea (introduceri de texte, selecţii, mutări, 

ştergeri, modificări de dimensiuni pentru linii şi coloane, etc.) tabelelor. 

 Cum se utilizează miniaturile, imaginile şi diagramele într-un document Word.  

 

 

3.5. Pregătirea imprimării 

3.5.1. Pregătiri preliminare  

Pentru a ne asigura că documentul va fi imprimat în forma dorită, se recomandă ca înainte de 

această acţiune să mai facem o ultimă verificare. Vom verifica conţinutul, aspectul (layout) şi modul 

de prezentare a documentului, precum şi ortografia.  

 

Această verificare  presupune: 
 

 Verificarea conţinutului documentului: 

- textul este scris corect, în întregime, fără omisiuni sau dubluri, 

- toate elementele de grafică sunt prezente în document. 
 

Se citeşte cu atenţie documentul şi se editează dacă apar neconformităţi. 
  

 Verificarea configuraţiei paginii: 

- verificarea dimensiunii hârtiei,  

- verificarea orientării paginilor în document, număr pagini pe foaie, 

- verificarea marginilor din afara zonei imprimabile,  

- verificarea antetului şi a subsolului. 
 

Se pot face ajustări alegând din tab-ul Aspect Pagină → Iniţializare pagină (Page Layout 

→ Page Setup). 

 Verificarea  modului de aşezare a informaţiei în pagină: 

- separarea textului în pagini,  

- aşezarea în pagină a textului şi a obiectelor inserate cum ar fi: Miniatură (Clip Art), 

Imagine (imagini aduse din fişier), Diagramă (Chart), Tabele (Table), etc. 
 

Se pot face corecturi modificând textul, modificând salturile la pagină nouă, schimbând 

poziţia obiectelor inserate şi stilul de încadrare al lor în raport cu textul învecinat. 
 

 Verificarea dimensiunii fontului utilizat pentru text (font size) şi a formatărilor aplicate 

textului, paragrafelor, documentului: 

- verificăm dacă textul este lizibil într-o vizualizare apropiată de dimensiunea foii de hârtie 
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şi dacă dimensiunea fontului este adecvată, 

- verificăm alinierea, indentarea şi spaţierea paragrafelor,  

- verificăm aplicarea de Marcatori şi Numerotare (Bullets şi Numbering), de Borduri şi 

Umbrire (Borders şi Shading), de Tabulatori (Tabs). 
 

Se pot face ajustări din fila Pornire (Home). 
 

 Verificarea ortografiei: 

- verificăm dacă din punct de vedere ortografic textul e scris corect. 
 

Se realizează: fie citind cu atenţie textul pentru a depista erorile,  

fie automat utilizând funcţia Verificarea ortografiei în timpul tastării (Check 

spelling as you type) care este de regulă activă şi ea face, ca în text, cuvintele 

scrise incorect ortografic, să apară subliniate cu o linie roşie ondulată.  

 

3.5.1.1. Verificarea ortografică a documentului 

Pe măsură ce utilizatorul creează documente pot apărea situaţii în care este necesară corectură 

pentru textul introdus.  

Depistarea erorilor de ortografie se poate face automat. Funcţia Verificarea ortografiei este de 

regulă activă şi ea face ca în text cuvintele scrise incorect ortografic, să apară subliniate cu o linie roşie 

ondulată. Cuvintele subliniate cu roşu sunt cele care nu sunt în dicţionarul predefinit al aplicaţiei (fie 

că sunt cuvinte incorect scrise, fie sunt corect scrise dar reprezintă nume proprii, termeni tehnici, 

prescurtări ale unor nume de firme, cuvinte scrise într-o limbă diferită de cea a dicţionarului folosit, 

etc.). 

 

Această funcţie se activează/dezactivează dintr-o fereastră de dialog dacă parcurgem paşii:  

Buton Office → Opţiuni Word → Verificare → zona La corectarea ortografică şi gramaticală 

în Word (Office Button → Word Options → Proofing → zona When correcting spelling and grammar 

in Word) se bifează / debifează caseta Verificarea ortografiei în timpul tastării (Check spelling as you 

type). 

 

Dacă funcţia este activată şi în textul documentului activ apar cuvinte subliniate cu o linie 

ondulată de culoare roşie, atunci este necesară corecţia erorilor. Acest lucru se poate face manual, sau 

automat folosind funcţia Corectare ortografică şi gramaticală... (Spelling and Grammer...). 
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 Cum se corectează automat greşelile? 
 

1. Se alege fila Revizuire → grupul Verificare → Ortografie şi gramatică... (Review → grupul 

Proofing → Spelling & Grammar...). Va fi activată următoarea fereastră de dialog: 

 

 
 

2. În fereastra de mai sus trebuie aleasă limba dicţionarului din lista corespunzătoare (de 

exemplu: Romanian (Romania) ). 
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3.  În partea de sus a ferestrei în zona Nu este în dicţionar: (Not in Dictionary:) apar marcate pe 

rând greşelile, iar în partea de jos în zona Sugestii: (Suggestions:) apare o listă ce cuprinde 

sugestii de modificare pentru cuvântul marcat.  
 

a)  Greşeala se poate modifica astfel: din lista de sugestii se alege cuvântul corect şi se 

execută clic pe Modificare (Change).  

b)  Greşeala poate fi ignorată (se trece la următoarea greşeală fără a o modifica pe cea 

selectată) cu ajutorul butonului Ignorare o dată… (Ignore Once).  

c)  Dacă un cuvânt se repetă imediat, atunci în casetă apare butonul Ştergere (Delete) care 

permite eliminarea celei de-a doua apariţii a cuvântului. 

 

Observaţie: Dacă la acest pas 3. s-a efectuat o acţiune greşită atunci aceasta se poate anula cu clic pe 

butonul Anulare (Undo). 
 

4.  Corectarea ortografică se poate termina: 

a)  Imediat după ce a fost lansată, prin clic pe butonul Revocare (Cancel). 

b)  În orice moment (după ce s-a efectuat cel puţin o modificare sau o ignorare) prin clic pe 

butonul Închidere (Close). 

c)  După ce tot textul a fost parcurs şi apare fereastra de mai jos se dă clic pe OK. 

 

Observaţie: Dacă acţiunea de alegere a limbii eşuează atunci se parcurg paşii: 

1.   Fila Revizuire → grupul Verificare → Setare limbă...  (Review → grupul Proofing → 

Set Language...). 

 

2.   Din caseta de dialog Limbă (Language) se alege limba dorită. 
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3.   Se debifează caseta  Detectare automată a limbii (Detect language automatically) şi 

Fără verificare ortografică sau gramaticală (Do not check spelling or gramemar). 

4.   Se închide caseta de dialog prin clic pe butonul OK. 
 

Notă 

Pentru o corectură individuală a cuvintelor se poate executa clic-dreapta pe cuvântul subliniat cu 

roşu (sau verde) iar din meniul de context se poate alege prin clic varianta corectă. 

 
Dacă apar cuvinte subliniate cu verde, înseamnă că se face şi o corectură din punct de vedere 

gramatical. Se renunţă la această funcţie parcurgând calea: Buton Office → Opţiuni Word → 

Verificare → zona La corectarea ortografică şi gramaticală în Word → se debifează caseta 

Marcare erori gramaticale în timpul tastării (Office Button → Word Options → Proofing → 

în zona When correcting spelling and grammar in Word → Mark grammar errors as you 

type). 

 

3.5.1.2. Examinarea documentului înaintea imprimării (Print Preview) 

Înainte de a imprima un document, acesta ar trebui examinat. Examinarea înaintea imprimării 

(Print Preview) oferă utilizatorului posibilitatea de a urmări modul de separare a textului în pagini, 

precum şi de a detecta unele probleme legate de aşezarea în pagină a textului şi a obiectelor inserate 

cum ar fi: imagini, grafice, diagrame, casete text etc.  
 

 Pentru a face această examinare se alege Buton Office → Imprimare → Examinare înaintea 

imprimării (Office Button → Print → Print Preview).  

Pe ecran va apărea tab-ul Examinare înaintea imprimării (Print Preview): 
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- Se poate modifica procentul de vizualizare din grupul Panoramare (Zoom). Dacă se 

doreşte la un moment dat examinarea unei singure pagini atunci se selectează butonul 

 O pagină (One Page). 

Pentru a vizualiza alte pagini, sau pe rând toate paginile din document, folosim barele de 

defilare. 

- Dacă se doreşte  editarea textului se vor parcurge următorii paşi: 

1.  Clic pe textul ce se doreşte a fi editat; Microsoft Word va mări zona respectivă 

2.  Se debifează opţiunea  Lupă (Magnifier); cursorul se va schimba din lupă în cursor de 

inserare text. 

3.  Se vor efectua modificările dorite.  

4.  Pentru a ne  întoarce la mărimea iniţială de vizualizare se face din nou clic pe butonul 

Lupă (Magnifier) şi apoi clic pe document. 

- Se revine din fereastra Examinare (Preview) în fereastra de editare Word, cu clic pe 

butonul  Închidere Examinare înaintea imprimării  (Close Print Preview).  

Observaţie: Se poate edita textul şi în fereastra Word şi apoi se poate examina documentul din nou. Se 

repetă aceste operaţii până în momentul în care documentul apare aşa cum se doreşte.  
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3.5.2. Imprimarea 
 

3.5.2.1. Alegerea opţiunilor de imprimare cum ar fi: imprimarea întregului 
document, a unor pagini indicate, numărul de copii 

Opţiunile pentru imprimare se stabilesc în caseta de dialog  Imprimare (Print) care apare dacă se 

alege Buton Office → Imprimare → Imprimare (Office Button → Print → Print): 

 

 
 

 În fereastra Imprimare (Print) se stabilesc: 

- numele imprimantei din lista Nume (Name); 

- paginile ce se vor imprima, în zona Interval de pagini (Page range), selectând una din 

variantele: 

o toate paginile - Toate (All) 

o Pagina curentă (Current page) 

o paginile selectate anterior comenzii Imprimare (Print) -  Selecţia (Selection) 

o anumite pagini - în caseta Pagini (Pages) – (Exemplu: 2,5,7,10-15) 

- tipărirea paginilor pare (Even pages) sau impare (Odd pages) se alege din lista Imprimare 

(Print);  

- numărul de copii (exemplare) în caseta Număr de copii: (Number of copies); 

-  Asamblare (Collate) – imprimă toate paginile specificate pentru un exemplar, apoi 

imprimă următoarea copie (exemplar), etc. 
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-  Imprimare în fişier ( Print to file), dacă utilizatorul nu are imprimantă disponibilă. Se 

salvează de fapt documentul într-un fişier, cu un nume indicat de utilizator, sub un format pe 

care îl poate utiliza imprimanta. Utilizatorul poate folosi apoi acest fişier pentru a-l imprima 

de la un alt calculator.  

- Dacă se modifică proprietăţile imprimantei butonul Proprietăţi (Properties) atunci butonul 

Revocare (Cancel) se transformă în Închidere (Close) şi se poate închide caseta de dialog 

Imprimare (Print) cu păstrarea proprietăţilor. 

 

Observaţie: Asiguraţi-vă mai întâi că imprimanta este pornită şi pregătită pentru imprimare.  

Dacă pentru imprimare s-a selectat  Imprimare în fişier ( Print to file), atunci 

documentul nu este trimis la imprimantă, ci într-un fişier pe disc. 

 

 

3.5.2.2. Imprimarea unui document de la o imprimantă instalată utilizând 
setările implicite 

 

Pentru o imprimare rapidă (nu mai apare caseta de dialog pentru imprimare) se alege Buton 

Office → Imprimare → Imprimare rapidă (Office Button → Print → Quick Print). 

 

Dacă se doreşte alegerea unei alte imprimante dintre cele instalate sau modificarea anumitor 

caracteristici de tipărire atunci se alege Buton Office → Imprimare → Imprimare (Office Button → 

Print → Print), se efectuează modificările cerute şi se execută clic pe butonul OK. 

Combinaţia de taste Ctrl + P deschide caseta de dialog Imprimare (Print). 

 

 

 

Ce aţi învăţat în acest capitol? 
 

 Cum se pregătesc documentele Word pentru imprimare 

 Care sunt  opţiunile pentru imprimare şi cum pot fi folosite acestea 

 Cum se imprimă un document 

 

 

 

3.6. Facilităţi de trimitere a unui document Word prin e-mail sau fax 

Aplicaţia Microsoft Word poate fi utilizată şi pentru a trimite documentele create în Word prin 

fax sau prin e-mail ca scrisori electronice (e-mail).  

Aceste ”scrisori electronice” pot fi trimise ca şi fişiere ataşate unui mesaj sau ca şi corp principal 

al mesajului. Mesajelor le putem adăuga semnături personalizate (Signatures) create special pentru 

diversele categorii de destinatari (Ex. prieteni, rude, scrisori oficiale, etc.). 

De asemenea Word-ul poate fi utilizat ca editor implicit de e-mail, caz în care avem la dispoziţie 

facilităţile de editare ale acestei aplicaţii.  
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Notă 

Pentru a trimite un document creat în Word în corpul unui mesaj, trebuie să fie disponibilă pe 

calculator aplicaţia Microsoft Outlook 2007.  

 

 Trimiterea unui document Word ca fişier ataşat unui mesaj (e-mail) 
 

Fişierul creat în Word poate fi trimis prin e-mail şi ca fişier ataşat unui mesaj. Alături de acesta 

pot fi ataşate şi alte fişiere. Pentru aceasta procedăm astfel: 
 

1. Se deschide sau se creează documentul Word ce se va trimite prin e-mail. 

2. Se alege Buton Office →  Trimite → Poştă electronică  (Office Button → Send → E-mail). 

Va apărea următoarea ferestră de dialog: 

 

 
 

3. Se introduce adresa de e-mail a destinatarului  în câmpul Către (To):  respectiv Cc, iar dacă 

sunt mai mulţi destinatari separăm adresele prin punct şi virgulă (;). 

4. În câmpul Subiect (Subject:) se introduce subiectul (automat apare scris numele fişierului). 

5. Dacă este nevoie se pot „ataşa” mesajului şi alte fişiere: clic pe butonul Ataşare fişier 

(Attach); se selectează fişierul ce urmează a fi ataşat; clic pe butonul Inserare (Insert). Se 

repetă paşii 4 şi 5 dacă se doreşte ataşarea altor fişiere.  

6. Se dă clic pe Trimitere (Send). 
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 Notă 

Pentru a fi disponibilă această procedură este necesar să fie disponibilă pe calculator una dintre 

aplicaţiile Microsoft Outlook 2007, Microsoft Outlook Express sau Microsoft Exchange. 

 

 Trimiterea unui document prin fax-modem 
 

Pentru a trimite documentul Word prin fax procedăm astfel: 

1. Se alege Buton Office →  Trimite → Fax prin Internet (Office Button → Send → Internet 

Fax). 

2. Dacă opţiunea este instalată atunci va apărea o fereastră ce conţine interfaţa programului de 

comunicare prin fax.  

3. Se introduc datele corespunzătoare  şi apoi se dă clic pe butonul de trimitere (Send Fax Now). 

 

 

 

Ce aţi învăţat în acest capitol? 
 

 Cum să trimiteţi un document Word ca e-mail 

 Cum să trimiteţi un document Word ca fişier ataşat într-un e-mail 

 Cum să trimiteţi un document Word prin fax-modem 
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3.7. Propuneri de realizare a unor aplicaţii practice 
 

 

Tema 1 
 

Scrieţi o scrisoare unei prietene/ prieten.  

Folosiţi facilităţile de formatare din Word şi realizaţi un design adecvat al documentului.  

Dacă scrisoarea se întinde pe mai multe pagini numerotaţi automat paginile în subsol. 

Salvaţi fişierul sub numele Scrisoare1. 

 

Creaţi o copie a fişierului salvat cu numele Scrisoare2. 

Modificaţi unele texte din conţinutul scrisorii şi salvaţi modificările. 

 

Dacă sunteţi conectat la Internet încercaţi să trimiteţi scrisoarea (fişierul Scrisoare2) prin e-mail 

la o adresă cunoscută. 

 

 

Tema 2 
 

Realizaţi o carte de vizită. Salvaţi documentul cu numele CarteVizita. 

 

 

Tema 3 
 

Scrieţi un CV (curriculum vitae) pentru dvs. sau pentru o cunoştinţă. Salvaţi documentul într-un 

fişier cu numele CV. 

 

 

Tema 4 
 

Creaţi următorul document cu pagină A4, orientare Portret şi margini de 2 cm de jur împrejur. 
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DDee  vviizziittaatt  îînn  BBUUCCUURREEŞŞTTII  
 

 

 

 Grădina Botanică 

 

A fost înfiinţată în 1860 din iniţiativa dr. Carol Davilla. În 1884 este reamenajată de prof. dr. D. 

Brândză creatorul Institutului Botanic din incintă. Are o suprafaţă de 17,5 ha (inclusiv serele) şi 

deţine cca 10.000 specii de plante de pe tot globul. 

 

 Grădina Cişmigiu   
 

A fost amenajată în 1830 de arhitectul peisagist german Carl Meyer la comanda prinţului 

Bibescu. Are o suprafaţă de 17 ha şi 30.000 de arbori aduşi din ţară. 

 

 Parcul Herăstrău  
  

A fost amenajat între 1920-1930 de arhitecţii peisagişti Pinard şi Rebhuhn. Se întinde pe 187 ha.  

Are lac natural, statui şi restaurante. 

 

   

 Edificii culturale 
 

1. Atheneul Român – ridicat între 1886-1888 după planurile arhitectului francez Albert 

Galleron. 

2. Teatrul Naţional  - clădire realizată între 1967-1970. 

3. Opera Naţională – 1953 construită după planurile arhitectului Octav Doicescu. 

4. Muzeul Naţional de Artă a României cuprinde peste 70.000 de piese. 

5. Muzeul de istorie Naturală „Grigore Antipa”  deţine peste 300.000 de exponate. 

6. Muzeul Colecţiilor de Artă  

7. Muzeul Naţional Cotroceni: are colecţii de artă veche europeană. 

8. Muzeul Ţăranului Rămân: cuprinde piese de artă populară românească şi străină. 

9. Muzeul Satului şi de Artă Populară: 

 - a fost creat în 1936 de prof. D. Gusti (1880-1955) întemeietorul şcolii româneşti de 

sociologie;  

- este situat pe malul lacului Herăstrău şi are o suprafaţă de 10 ha;  

- muzeul conţine case şi obiecte vechi originale. În cadrul muzeului sunt organizate 

manifestări folclorice şi demonstraţii etnografice. 
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Fructe cumpărate 

Fructe / Cantitate Ianuarie Februarie 

Mere 2  3 

Struguri 3  2 

Cireşe 1  5 
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